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Please ensure you follow every step in order.

If your system does not comply with this list, DO NOT continue the install!

Overview of the Installation

System Requirements

Optimal Requirement (CPU, Memory, HHD and SO)
o Processor: i7 3.5GHz 4770K or better

Hard Drive: SSDs with 500MBs or greater

Memory: 12 GB DDR3 1666MHz or greater.

Motherboard: x79 Chip

Windows 7 pro and Windows 10 64 bit only

O O O O

Minimum Requirement for software WITHOUT variable data (CPU, Memory, HHD and SO)
o Processor: Intel i5
o Hard Drive: 7200 RPM
o Memory: 8 GB
o Windows 7 Pro and Windows 10 64 bit only

Power 120v and 220v
o Minimum outlets (5)

Network
o (2) IP Addresses for the Feeder and Printer
o (3) Network Cables

Before starting the software installation, you need to ensure that you have a clean
version of Windows 7 or 10 with nothing installed. In order to do so, you will need to
make sure of the following:

]
O
O

There are no applications installed or currently running.

There are no antivirus programs installed.

The computer you’re planning to install the software on has the printer and
feeder on the same network.

Ensure your user account has Administrator privileges on the local
computer.



1.1 Safety Information

Your UniNet product has been carefully designed to give you years of safe, reliable performance. As with all electrical
equipment, there are a few basic precautions you should take to avoid hurting yourself or damaging the product.

Warning - Here are some of the things to look for:

Save all provided documentation for future reference. Ensure all warning and instruction labels on the product are
read, understood and followed in order to prevent any risk of injury.

This product may be heavy. Please check the weight of the product and take all necessary precautions to prevent
the risk of personal injury. Place your product on a firm, solid surface. If placed on something unsteady, it may fall
and be damaged. If placed on a soft surface, the vents may be blocked, causing the product to overheat.

If the product is installed on a cabinet or high capacity feeder, ensure wheel locks are applied once placed in final
position for use, to prevent risk of movement or injury.

Protect your product from overheating. Make sure no obstructions block the openings of the product. Do not put the
product on or near a heat source (such as a radiator or heat register). Keep the product out of direct sunlight. Allow
enough room around the product for adequate ventilation and easy access to the paper paths. If the product is
placed in any kind of enclosure, make sure the enclosure is well ventilated to prevent a fire.

When the product cover is open, do not touch the fuser unit or print head as you may receive burns. Allow it to cool
before touching.

If the product casing gets extremely hot or smoke, unusual smells or abnormal noises are emitted from the product,
there is a risk of fire. Unplug the mains connector and contact UniNet service.

Do not use the product near water. Do not spill liquid of any kind on it. Do not connect or disconnect the power plug
with a wet hand as this may cause electric shock. Unplug the product before you clean it. Use only a damp cloth;
do not use liquid or aerosol cleaners. Do not use an extremely flammable spray near the product as the product
contains high temperature parts that may cause a fire.

Be certain that your power source matches the rating listed on the back of the product. If you are not sure, check
with your dealer or local power company before connecting the product.

Do not connect this product to an uninterruptible power supply (UPS).

Your product has a grounded, three-prong plug as a safety feature. This plug only fits into a grounded outlet. If the
plug does not fit, the outlet may be an older, non-grounded type. Contact an electrician to have the outlet replaced.
Do not use an adapter to defeat the grounding.

Install the product near an easily accessible power outlet and avoid damaging the power cord. Do not put anything
on it or place it where it will be walked on. If the cord becomes damaged or frayed, replace it immediately.

If you are using an extension cord or power bar with the product, make sure the total amperes required by all the
equipment on the extension is less than the extension’s rating. The total ratings of all equipment plugged into the
outlet should not exceed 15 amperes.

Do not poke anything in the ventilation slots of the product. You could get an electrical shock or cause hazardous
electrical arcing, which could cause a fire.

The acoustic noise of this product is less than 70 dB (A) as measured in accordance with EN ISO 7779.

The operating condition range for your product is: 10 to 32°C and 20 to 80% RH. Operation of the product outside
this range could result in damage to the product.

Do not throw toner cartridges or image drum cartridges into a fire as you may receive burns from a dust explosion.
Ensure loose clothing and hair is kept clear of moving parts when the product is in operation to prevent possible
risk of injury.

Ensure both the product and mains power switches are in the OFF position before connecting the AC power cable.
Always hold the power plug to connect/disconnect the power cable to/from the mains socket. Unplugging by pulling
on the cable can cause fraying and may lead to fire or electric shock.

Use only the power cable supplied. Using a power cable not intended for this product may lead to fire or electric
shock. Do not use the power cable supplied with this product for any other electrical equipment.

Aside from the routine maintenance described in the documentation, do not try to service the product yourself.
Removing the cover may expose you to shocks or other hazards.

Do not make any adjustments other than those outlined in the documentation. You may cause damage that will
require extensive repair work. The provided documentation explains how to get your product serviced by qualified
UniNet technicians. If anything happens that indicating your product is not working properly or has been damaged,
unplug it immediately and follow the procedures in the provided documentation for having your product serviced.



1.2 System Specifications

iColor 700: System Specifications

Print Speed Up to 9.14 meters/min (30 ft/min)

Technology Single Pass 4 Color LED (CMYK)

Printer Processor?! 533 MHz

Media Width Minimum: 6.0 inches (152.4 mm)
Maximum: 8.5 inches (216 mm)

Print Width Minimum: 6.0 inches (152.4 mm)

Maximum: 8.24 inches (209.3 mm)

Print Length

Up to 420 meters (1378 ft)

Substrate Types?

Die Cut Label Stock
Kiss Cut Label Stock
Non Die Cut Label Stock
Tag Stock

Print Quality

1200 x 600 dpi

Toner Supplies®

CMY - 11,500 pages @ 5%
K - 11,000 pages @ 5%
(Rated according to ISO/IEC 19798 guidelines)

Drum Supplies*

CMYK - 30,000 pages @ 5%
(Rated according to ISO/IEC 19798 guidelines)

Feeder System

Input roll maximum outside diameter: 8 inches (203 mm)
Core inside diameter: 3 inches (76.2 mm)

Maximum input roll weight: 14 Ibs (6.35 kg)

Cut on the fly, auto cut

Auto page width registration

Front Panel LCD interface

Web management system torque

Auto adjusting form synchronization

Rewinder System

Output roll maximum diameter: 8 inches (203 mm)
Core inside diameter: 3.0 inches (76.2 mm)
Maximum output roll weight: 14 Ibs (6.35 kg)

Dimensions (H X W X D)

Printer & Feeder: 26" x 17.1 "x 21.5" (660 mm x 434 mm X
546 mm)
Rewinder: 16" x 19.75" x 19" (406 mm x 502 mm x 483 mm)

Weight

Printer & Feeder: 110 Ibs (49.9 kg)
Rewinder: 27.65 Ibs (12.54 kg)

Operating Environment

Temperature: 10°C to 20°C (50 to 89.6°F)
Humidity: 20 to 60% RH

Power

110 - 127 VAC, 50/60 Hz @ 1150W
220 - 240 VAC, 50/60 Hz @ 1150W

Certifications

FCC Class A, CE, cTUVus, CCC

Warranty

1year — Parts & Labour

1.Published performance results based on laboratory testing. Individual results may vary.

2.This product is designed and engineered to operate only with genuine UniNet consumables and
certified media substrates. Please contact UniNet for the most current Certified Media List of
substrates available.

3.Letter-size sheets at 5% coverage. Printer ships with a 7,500 page set of starter toners.

4.Based on 500 cut-sheet pages/job.

UniNet reserves the right to change product specifications without notice. Trademarks are the property

of their respective manufacturers. ©2014 Copyright, UniNet. All Rights Reserved. All content is subject

to change without notice.




1.3 Roll Specifications
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Packaging Notes ‘

1.) Core plugs must be used

2.) Roll edges must be fully supported to prevent
damage to the roll during shipping

3.) Media roll must be protected from moisture
absorption

Non Die Cut Label Notes

1.) No sync marks needed

Kiss Cut Label Notes ‘

1.) Must use sync mark
2.) Left & right margins 0.063” minimum
3.) Label gap & gutter spacing 0.125” minimum
4.) Label corner radius
a. Using sync mark = No Limit
Note: Cannot use gap sense method

Roll Notes

1.) Image side wound out
2.) Core:
a.) Inside diameter = 3.01” — 3.025”
b.) Thickness = 0.250”
3.) Core must be flush or inset < 1/16” at each end
4,) Core must be attached to the label material
using either double sided releasable tape or low
tack glue
5.) Leading edge must be square and clean
6.) Roll coning is not allowed
7.) Splicing is not allowed
8.) Glue ooze is not allowed
9.) Roll outside diameter = 8.0” maximum
10.) Roll weight = 30lbs maximum

Die Cut Label Notes:

1.) Can use either gap sensor or sync mark (see
limitations below)

2.) Left & Right Margins:
a. Using gap sensor = 0.063” maximum
b. Using sync mark = No Limit

3.) Label gap & gutter spacing 0.125” minimum

4.) Label corner radius
a. Using edge sensor = 0.125” maximum
b. Using sync mark = no limit (ie. Circles)

Sync Mark Notes:

1.) Each label row is to be marked with a sync mark
2.) Sync mark the right edge of the label material as
it unwinds
3.) Sync mark using a black i-mark
a. DIMC =0.125" wide x 0.5” long
b. Offset from edge = 0.030”
4.) Sync marks are to be accurately placed
between each tag or label in the gap area
a. DIM B - TBD (Depends on the size of the tag or
label)
5.) Sync mark density:
a. 1.2 ortho (matte black finish)




1.4 iColor 700 Front View

@ =

©®N g

LED Heads

Toner Cartridges (C, M, Y, K)

Front Cover Release Lever (Blue Handle
Behind Cover)

Cut On The Fly Module

Feeder Display Menu

Spindle Pin

Left and Right Media Guides

Static Bar

Front Cover

10.
11.
12.
13.
14.
15.
16.
17.

Black Tray Latches

Width Adjustment Wheel
Extension Arms

Feeder

Top Cover Release Button
Drum Units (C, M, Y, K)
Rewinder

Fuser Release Levers




1.5 iColor 700 Rear View

Printer Network Connection

Printer Power Outlet

Feeder Network Connection

Feeder Power Outlet

Paper Exit Path

Rewinder Plate (Rewinder Not Shown Attached)

Uk whE

Note: USB port is not available
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1.6 iColor 700 Internal Feeder View

Drive Roller

Left and Right Media Guides
Tension Roller

Pinch Roller

Static Bar

Black Tray Latches

Width Adjustment Wheel
Extension Arms

Spindle Pin
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1.7 iColor 700 Rewinder View
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1.8 Feeder Display Menu Functions
1 2 2 4 5

agprwNE

Display — Displays the feeder status and any error messages

On Line/UP — Toggles between Online and Offline, and also serves as an “UP” selection button

DOWN - Serves as an “DOWN” selection button

Load Button — Press to complete loading paper

Menu/Select - Accesses the three menus: Feeder Configuration, Feeder Calibration and Network Settings

To access the feeder menu items, press the On Line button to toggle online or offline and gain access to your Menu
system. There are three main menu items: Feeder Configurations, Feeder Calibrations and Network Settings.

M1: Feeder Configurations — NOT AVAILABLE

To access the feeder configuration menu, select On Line to turn the feeder offline. Press the Menu key once for
the M1: Feeder Config menu to appear. The following item is under Feeder Config:

11:
Media
Type

To access the 11: Media Type menu, select the On Line button to take the feeder offline.

To change the media type, hold down the Menu key until the * disappears. Use the UP and DOWN
arrow keys to select the required media. To save the selection, hold down the Menu key again until the
* appears. The media type is now set. To exit press the Menu button. Select On Line button to take the
feeder back online.

M2: Calibrations

Under the Calibrations menu items, it is possible to configure both the Top and Bottom Load Sensors, the Sensor Gap,
Cut on the Fly parameters and Auto Calibration menus.

To access the M2: Calibrations menu, select On Line to turn the feeder offline. Press the Menu key twice for the M2:
Calibrations menu to appear. The following items are under Calibrations:

11: Bot
Load
Sensor

This item configures the parameters for the bottom load sensor. To access the 11: Bot Load Sensor menu,
select the UP arrow until I11: Bot Load Sensor is shown on the display.

To change the settings, hold down the Menu key for about one full second until the * disappears. Use the
UP and DOWN arrow keys to set the required values. To save the values, press Menu. When all values
have been set, press and hold the Menu key for about one full second, until the * appears. The bottom
load sensor values are now set. To exit press the Menu button. Select On Line button to take the feeder
back online.

12: Top
Load
Sensor

This item configures the parameters for the top load sensor. To access the 12: Top Load Sensor menu,
select the UP arrow until 12: Top Load Sensor is shown on the display.

To change the settings, hold down the Menu key for about one full second until the * disappears. Use the
UP and DOWN arrow keys to set the required values. To save the values, press Menu. When all values
have been set, press and hold the Menu key for about one full second, until the * appears. The top load
sensor values are now set. To exit press the Menu button. Select On Line button to take the feeder back
online.
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I13: Reg
Sensor
Back

This item configures the gap between back sensors. To access the 13: Reg Sensor Back menu, select the
UP arrow until 13: Reg Sensor Back is shown on the display.

To change the settings, hold down the Menu key for about one full second until the * disappears. Use the
UP and DOWN arrow keys to set the required values. To save the values, press Menu. When all values
have been set, press and hold the Menu key for about one full second, until the * appears. The back
sensor or gap values are now set. To exit press the Menu button. Select On Line button to take the feeder
back online.

14:
RSEN
Autocal

This item configures the auto calibration values. To access the 14: RSEN Autocal menu, select the UP
arrow until I14: RSEN Autocal is shown on the display.

To change the settings, hold down the Menu key for about one full second until the * disappears. Use the
UP and DOWN arrow keys to set the required values. To save the values, press Menu. When all values
have been set, press and hold the Menu key for about one full second, until the * appears. The
autocalibration values are now set. To exit press the Menu button. Select On Line button to take the feeder
back online.

I5:
COTF
Paramet
ers

This item configures the parameters for Cut on the Fly. To access the I5: COTF Parameters menu, select
the UP arrow until I15: COTF Parameters is shown on the display.

To change the settings, hold down the Menu key for about one full second until the * disappears. Use the
UP and DOWN arrow keys to set the required values. To save the values, press Menu. When all values
have been set, press and hold the Menu key for about one full second, until the * appears. The COTF
parameter values are now set. To exit press the Menu button. Select On Line button to take the feeder
back online.

M3: Network Settings

The Network Settings menu items allow configuration of the IP Address, the Subnet Mask and the Default Gateway.

To access the M3: Network Settings menu, select On Line to turn the feeder offline. Press the Menu key three times

for the M3:

Network Settings menu to appear. The following items are under Network Settings:

This item sets the IP Address. To access the 11: IP Address menu, select the UP arrow until 11: IP
Address is shown on the display.

Addlitzaslz To change the settings, hold down the Menu key for about one full second until the * disappears. Use
the UP and DOWN arrow keys to set the required values. To save the values, press Menu. When all
values have been set, press and hold the Menu key for about one full second, until the * appears. The
IP Address now set. To exit press the Menu button. Select On Line button to take the feeder back
online.

This item sets the Subnet Mask. To access the 12: Subnet Mask menu, select the UP arrow until 12:
Subnet Mask is shown on the display.
12:
Subnet | To change the settings, hold down the Menu key for about one full second until the * disappears. Use
Mask | the UP and DOWN arrow keys to set the required values. To save the values, press Menu. When all
values have been set, press and hold the Menu key for about one full second, until the * appears. The
Subnet Mask is now set. To exit press the Menu button. Select On Line button to take the feeder back
online.
This item sets the Default Gateway. To access the I13: Gateway menu, select the UP arrow until 13:
Gateway is shown on the display.
13:
Gateway | To change the settings, hold down the Menu key for about one full second until the * disappears. Use

the UP and DOWN arrow keys to set the required values. To save the values, press Menu. When all
values have been set, press and hold the Menu key for about one full second, until the * appears. The
default Gateway now set. To exit press the Menu button. Select On Line button to take the feeder back
online.
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1.9 Printer Operator Panel
2

HELP Ready To Print ENTER ONLiNe  Cancer
@
10 6 5 f & 8 4 9
ON: A warning occurs. Printing
ON: Ready to receive data Qf?’,\ﬁﬁg?iﬂee%?'o I((:)(\:/\L/J:gner)
1.Ready LED BLINKING: Processing data 6. Attention LED - X . ’
. ; Printing not possible (e.g. toner
OFF: Offline
empty)
OFF: Normal Condition
2. Display Displays the printer status and any 7. Back Button Returns to the previous menu

error messages.

3. Menu Scroll

Enters the Menu mode. In Menu
mode, forwards or reverses the
menu item displayed.

8. Enter Button

In the ONLINE or OFFLINE mode:
enters the Menu mode.

ELLIRLE In the Menu mode: determines the
Press for 2 seconds or longer to setting selected
jump from top to bottom 9 )
Deletes the data being printed or
Switches between ONLINE and received when pressed for two
4.0n Line OFFLINE 9. Cancel Button seconds or longer.
Button

Scrolls the HELP screen

Exits the menu and goes ONLINE
when pressed in the Menu mode.

5. Help Button

Provides advice when an error
occurs

10.Power Save/
Wake up Button

Pressing this button switches the
machine into sleep or wake- up
mode.




2 First Time Setup

2.1 Unpacking and Setting Up the Printer

STEP 1 of 11

-

N

(cAUTiON [

/&—f

STEP 2 of 11

With two people lift the top (feeder) box off of the
bottom (printer) box. Open the feeder box and
remove the feeder.

Remove the wing nut on the bottom of the feeder
before placing upright on any surface. Position the
feeder on a level surface. Open the feeder and
remove all packaging material. Close the feeder

door.

Lift the lid off of the printer box. With two people,
remove the printer from the box. Remove all of the
packaging tape from the outside of the printer.

STEP 3 of 11 |

STEP 4 of 11

Press the button to open the top lid.

Remove the fuser shipping lock.
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STEP 5 of 11

STEP 6 of 11

Pull the drums/toners out of the printer. Remove the
protective film. Place the drums and toners back into
the printer. Ensure all four toners are locked into the
four drums by checking the blue lever. Close the
printer lid.

IMPORTANT: Once the drums/toners are removed,
they must not be exposed to light for more than 5
minutes. To prevent damage, cover them with a dark
sheet or reinstall.

NOTE: All consumables are print ready and do not
need to be replaced upon opening. Once the
consumables have reached their lifespan, please
refer to the appendix on how to replace and install
all consumables

Align the printer with the pins located on the top of the
feeder. Keep the printer level and flush to the front
while lowering it onto the feeder.

STEP 7 of 11

STEP 8 of 11

}—PRewinder Plate

Unpack the rewinder, removing all of the packaging
tape.

Unwrap the rewinder attachment and prepare to
install on the printer.

Attach the rewinder plate to the feeder using the screws
located on the back of the feeder. Make sure itis in line
with the paper output feeder. You can adjust the
rewinder plate once it is loosely secured by moving it
slightly left or right. Adjust accordingly.

17



STEP 9 of 11

H
Thumb Screws ‘

4

Attach the rewinder mechanism to the plate using the black thumbscrews. Make sure that the rewinder mechanism

is fully supported so it does not bend or break the rewinder plate. The rewinder attachment has been successfully
installed.

STEP 10 of 11

Paper Exit Path
Printer Network

Connection

Feeder Network

Connection 2 E
Feeder Power Outlet—@

-

Rewinder Plate

Once the rewinder is installed, you need to connect the network and power cables to the correct outlets. All of the
outlets are located on the backside of the iColor 700; connect accordingly.
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]

Press power button on the side of the printer. Wait for the initialization. You should read Ready To Print on the
printer panel and Status: Require Load on the feeder panel. The rewinder attachment has been successfully
installed.

19



2.2 How To Get Software Installation Files

STEP 10f4

+
e

EDGE2Print

217.99 MB 29 days ago
17.99 MB 5 months ago
7.99 MB & months ago
8.25 MB 29 days ago
B v

-

£ >
UniNet utilizes Dropbox for sending the software file. Please send UniNet an email for sharing folders. After this emalil
confirmation, UniNet will send a link for the software to your email address. Click the link and you will see the above
website. Click Download on the top right, and click Download as .zip.

STEP 2 of 4
@ Sove hs S0

@.uvlz Desktop »

v|&7H Search Desktop

45 Favorites
B Desktop
Recent Places
Cloudstation
%7 Dropbox
[] iCloud Photos
4/ Libraries
=| Documents
& Music
=] Pictures

B videos

» oy Homegroup

Organize v Newfolder

2
w

A

18

File name: EDGE2Print.zip

Libraries
System Folder

Administrator
System Folder

Network
System Folder

Virtual Machine
File folder

L

S8

|

Homegroup
System Folder

Computer
System Folder

815
File folder

Save 35 type: | Compressed (zipped) Folder

4 Hide Folders

Save Cancel

Select a place to save your file. (e.g. on Desktop), Click Save.
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Open

o Extract All Select a Destination and Extract Files
¥ Agent Ransack Files will be extracted to this folder:
: :\Users\Administrator\Desktop\EDGE2Print] [ Browse...

Copy (FastCopy)
Delete (FastCopy)

[7] Show extracted files when complete

Search and Replace...

& TortoiseSVN >
1-Zip »
[&f  Edit with Notepad++
£?  Move to Dropbox

Go to the place to get your .zip file, right click and select Extract All. On the pop-up window, select a place o save
your folder and click Extract.

STEP 4 of 4

Now you have the folder for the software installation.
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2.3 Change User Account Control Settings

STEP 1 of 6

"3 Windows Explorer
u=pil

E] Visual Studio 2012 '
- I MNotepad 3

N Internet Explorer »
& e

Music

A< Adobe Acrobat X Pro ,
Computer
iSys
—
= Control Panel
i’ | OpenDifice.crg Cale , R
Change se
l.. Microseft Office Visio 2007 3
Default Programs
@) Microsoft Visual Studio 2008 3

Help and Support
! L2 APEX2Print

»  AllPrograms

a I <& print save in sp...

In order to prevent some administration window popping up when you use EDGEZ2Print, Please change your user
account control setting.

Click Start from Windows toolbar, and then click Control Panel.

STEP 2 of 6

FEI Control Panel

If using Windows 8, point your mouse to the upper-right corner of the screen, move the mouse pointer down,
click Search, enter Control Panel in the search box, and then click Control Panel.

STEP 3 of 6

(S [ s Control Panel » ~[+4][[5earch Con.. P |

Adjust your computer’s settings View by: Category

System and Security
Review your computer's status
Back up your computer

Find and fix problems

Network and Internet
View network status and tasks
Choose homegroup and sharing options

Hardware and Sound
View devices and printers
Add a device

User Accounts and Family Safety

) Add or remove user accounts
) Set up parental controls for any user

Appearance and Personalization
Change the theme

Change desktop background

Adjust screen resolution

Clock, Language, and Region

Change keyboards or other input methods

=—¢ Programs

e § &

I; =LJ Uninstall a program

Click User Account and Family Safety.
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STEP 4 of 6
SN

@@v\;ﬂd » Control Panel » User Accounts and Family Safety » BN E

Control Panel H
e User Accounts

Change your ac

g

unt picture | B Add or remove user accounts
ur Windows password

System and Security
Changey

Network and Internet
Hardware and Sound [" Parental Controls
&3 & Set up parental controls for any

Programs

User Accounts and Family 3 Windows CardSpace
Safety Manage Information Cards that are used to log on to online services

Appesrance and Credential Manager

Personalization < .

& Manage Windows credentials
Clock, Language, and Region
i (@ Meail (32-bit)

Click User Accounts.

STEP 5 of 6

@‘\)vlﬂ* » Control Panel » User Accounts and Family Safety b User Accounts

Control Panel Home
Make changes to your user account

Manage your credentials

Create 3 password for your
Create a password reset dick - -
Change your picture Administrator
Link enline IDs Administrator
Manage your file encryption
certificates ® Manage ancther account

Configure advanced user @ Change User
profile properties

unt Control settings

Change my environment
variables

® Parental Controls

Click Change User Account Control settings.

STEP 6 of 6

) User Account Control Settings &) User Account Control Settings
Choose when to be notified about changes to your computer Choose when to be notified about changes to your computer
User Account Control helps prevent potentially harmful pragrams from making changes to your computer. User Account Control helps prevent patentially harmful pragrams from making changes to your camputer,
iTell me more about User Account Control settings Tell me more about User Account Control settings
Always notify Ahways notify
—=- Always notify me when: il Never notify me when:
®  Programs try to install software or make changes to & Programs try to install software or make changes to
my computer my computer
©  Imake changes to Windows settings ©  Imake changes to Windows settings
Not recommended. Choose this only if you need to
Recommended if you routinely instsll new software use programs that are not certified for Windows 7
J and visit unfamiliar websites. -0- because they do not support User Account Control,
Never notify Never notify
foK | [ Cancel foK | [ Cancel

Move the left bar all the way down to the bottom and click OK.
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2.4 Change Region Format

STEP 1 of4

B

To prevent the confusion of measurement units display in EDE2Print, we recommend to change region format to
English (Canada).

Click Start from Windows toolbar then click Control Panel. (For Windows 8, follow STEP 2 in Section 2.3.)

STEP 2 of 4

=2 5
S @ co

€y R

@ Ay

- - v R

& @ - ‘

Click Clock, Language, and Region.

STEP 3 0of 4

o | 3 b

Click Region and Language.

STEP 4 of 4

¥ Region and Language.

Fommats | Location | Keyboards and Languages | Administrative

Format:
[English (Canadia) -]
Dutch (Netherlands) a

English (Australia)
English (Belize)

English (Caribbean)

English (India)

English Ireland)

English (Jamaica)

English (Malaysia)

English (New Zealand)

English (Republic of the Philippines)
English (Singapore)

English (South Africa)

From the Format list, select English (Canada) and then click OK.
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2.5 How to Install RIP

STEP 1 of 4
T - i
‘ » EDGE2Print » v [ 49 | Search EDGEZPrint |
1 4 Open Include in library v Share with v Burn  » 35 v [ ‘9‘

Organize v

1st Install RIP
[, EDGE2Print_setup.exe

I —

Double click the folder of 1st Re-lns]all RIP.

NOTE: RIP must be installed before EDGE2Print.

STEP 2 of 4
- ‘ +3 | | Search Ist Install R

@-v-vl « 2015... » Lstln.. »
Open Burn Mew folder FE -

Organize =

Files
= | Prepare_iSys_RIP_v2.5.exe

Click Prepare_UniNet_RIP_v2.5.exe to install.
o Prepare iSys Rip v2.5 = =l . EK_I

Insert Dongles Into USE Ports And Click Here
To Continue

The KEYLOK Driver and Sentinel Driver will start to install automatically. Wait until the button turns to green. Insert

your dongles and click the button to continue.
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STEP 4 of 4
oSl Prepare iSys Rip v2.5 == E

Done

%

Wait until the Done button turns to green. Click it to finish the installation.

26



2.6 How to Install EDGE2Print

STEP 1 of4

-

» EDGE2Print »

Organize v @ Open Share with v Burn New folder

1st Install RIP
[Z; EDGE2Print_setup.exe

|
L

Double click EDGEZPriﬁt_setup.exe.

STEP 2 of 4
(Z Setup - EDGE2Print E-E

Ready to Install
Setup is now ready to begin instaling EDGE2Print on your computer.

Click Install to continue with the installation.

Click Install to continue. The window will disappear after the installation is done.

Open
Open file location

Pin to Start

'E‘;' Run as administrator
Troubleshoot compatibility
Pin to Taskbar

Send to 4
Cut
Copy

Create shortcut
Delete

Rename

Properties

If you're using on Windows 8 and have some administration pop up window when you launch EDGE2Print software,
please right click the icon, and select Properties.
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STEP 4 of 4
P EDGE2Print Properties =

General | Shortcut | Compatibiity | Security | Details

If this program isn't working comectly on this version of Windows,
try running the compatibility troubleshooter.

| Run compatibility troubleshooter |

Compatibility mode
[ Run this program in compatibility mode for:

Settings

Reduced color mode

ca

bit (256)

480 screen resolution

Runin &

Disable display scaling on high DP| settings

Privilege level
Run this pragram as an administrator

'E‘_;'Change settings for all users

QK Cancel Apply

Click Compatibility tab, check the box before Run this program as an administrator, and click OK to apply.
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2.7 Setting up the IP Addresses

In order to connect to the iColor 700, you need two predetermined static IP Addresses and two network cables,
one for the printer and one for the feeder.

2.7.1 Setting up the IP Address on the Printer

STEP 1 of 10

delegates.xm

W) [Id

readme.htm
< | readme.htm
< | SectionF.45.html

See more results

!cmd| X | Shut down | » |

Keep the network cable unconnected to the printer. Click Start from windows toolbar (For Windows 8, point your
mouse to the upper-right corner of the screen, move the mouse pointer down, click Search), type cmd in the search
dialogue and press Enter.

NOTE: Before you input the IP in the printer, you must check whether this IP is available to use.

\emd. exe

oft Windous [Version 6.1. BRIl icrosoft Windous [U n 6.1.76811
Copyright <c> 2009 Microsoft Corporation. A1l rights reserved. lCopyright <c> 2889 M oft Corporation. ALl rights reserved.

C:\WUsers\Administratordping 192.168.182.222_ C: \Msers\idninistrator>ping 192.168.182 222

[Pinging 122.168.182.222 with 32 bytes of data:

[Reply from 192.168.182.149: Destination host unreachable.
[Reply from 192.168.182.149: Destination host unreachable.
[Reply from 192.168.182.149: Destination host unreachahle.
[Reply from 192.168.182.149: Destination host unreachable.

cs for 192.168.192.222:
Sent = 4, Received = 4, Lost = @ (Bx loss>,

C: Wsers\Adninistrator>,

Enter "ping <IP address>" (for here is 192.168.102.222) you want to use for the printer, press Enter.

If it shows unreachable like the right picture, the IP address is not in use and you can use this IP for your printer.
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STEP 3 of 10 ]

Once your IP address is correct, go to your printer panel.
Press ENTER to enter the printer menu.
Using DOWN arrow to scroll to Admin Setup, press ENTER.

STEP 4 of 10 . _

At the Enter Password prompt, enter the 6-digit Admin password by using the UP/DOWN arrow, then Enter.
The default password is: aaaaaa(6 x a).

STEP 5 of 10 ,

S Setup
FPCL Setup

Press ENTER to select Network Setup.
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STEP 6 of 10 .

Network Setup
NetWare

EtherTalk
LFIP Address Set

Hit the DOWN key until you select IPv4 Address then Enter. Use the UP/DOWN arrow keys to set the value you
need. Press Enter to move across the address. After the value is set, press Back to Network Setup.

STEP 7 of 10 I "

1y
RRE

MNetwork Setup
Ether Talk

IP &ddress Set
1Pyd Sddress

. — - — B el
Hit the DOWN key to select Subnet Mask. Use the UP/DOWN arrow keys to set the value you need. Press Enter
to move across the address. After the value is set, press Back to Network Setup. (The default subnet mask is
255.255.255.0).

STEP 8 of 10

......
P - - - 4 5
~ T
.

T Gateway Address

l* . 168, 102. 1

Hit the DOWN key to select Gateway Address. Use the UP/DOWN arrow keys to set the value you need.
Press Enter to move across the address. After the value is set, press Back to Network Setup.
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STEP 9 of 10

Press ON LINE to exit the menu. NOTE: Write down this IP address as you will need for the software.

STEP 10 of 10
BN Administrator: C\Windows\system32\cmd.exe

C:\Users\Administrator>ping 192.168.182.222

[Pinging 192.168.182.222 with 32 hytes of data:

[Reply from 192.168 : ination host unreachable.
[Reply from 192.168 nation host unreachable.
[Reply from 192.168.1 nation host unreachable.
[Reply from 192.168.182.14! nation host unreachable.

[Ping statistics for 192.168.182.222:
Packets: Sent = 4, Received = 4. Lost = B <@z loss),

C:\Users\Administrator>ping 192.168.162.222

[Pinging 192.168.102.222 with 32 hytes of data:
Reply from 192.168.102.222: hytes-32 time<ims TTL-64

Reply from 192.168.102.222: byt time<ims TTL-64
Reply from 192.168.102.222: time<ims TTL=64
Reply from 192.168.102.222: timedins TTL=64

Connect the cable to the printer and now go back to your computer cmd interface, enter "ping <IP address>" (for
here is 192.168.102.222), press Enter again. You should get response this time. If you're not getting reply as in the
picture, please contact your IT support team.
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2.7.2 Setting up the IP Address on the Feeder

STEP 1 of 10

= delegates.xm
2 readme.htm
cf readme.htm

2 | SectionF.45.html

See more results

'cmd| x | | Shut down | » |

\q Trouble Shooting ...

Keep the network cable unconnected to the printer. Click Start from windows toolbar (If using Windows 8, point your
mouse to the upper-right corner of the screen, move the mouse pointer down, click Search), type cmd in the search
dialogue and press Enter.

NOTE: Before you input the IP in the feeder, you must check whether this IP is available to use.

oft Windous [Uersion 6.1.76011 Microsoft Windows [Uersion 6.1.76811
Copyright (c> 2889 Microsoft Corporation. A1l rights reserved. [Copyright <c> 2889 Microsoft Corporation. A1l rights reserved.

IC:\sersMdninistrator>ping 192.168.102.221 IC: sers\Administrator>ping 192.168.1082 221

[Pinging 192.168 221 with 32 hytes of data:

[Reply from 192.168 - H stination host unreachahle.
[Reply from 192.168 i i reachahle .
[Reply from 192_.168. - H i reachable .
[Reply from 192.168.102.142: i reachahle .

[Ping statistics for 192.168.182.221:
Packi Sent = 4. Received = 4. Lost = B <(B% loss),

IC: Wsers\Administrator>

Enter "ping <IP address>" ( for here is 192.168.102.221) you want to use for the printer, press Enter. If it shows
unreachable like the right picture, the IP address is not in use and you can use this IP for your feeder.

STEP 3 0of 10

i _—

Once your IP address is correct, go to your feeder panel. Press On Line to turn the feeder Offline.

33



STEP 4 of 10

Press Menu button three times until M3: Network Settings is shown.

STEP 5 of 10

I1: IP Address

Press the UP arrow key to get I1: IP Address.

STEP 6 of 10

el

Hold the Menu button until the * starts to flash. Use the UP and DOWN arrow keys to set the values. Press Menu
button to move across the IP address. When the address is set, hold the Menu button until the * stops to flash.
The IP address is now set.
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STEP 7 of 10

Mazk
55, A0

Press the UP arrow key to set the Subnet Mask. The default subnet mask is 255.255.255.0. If that needs to be
changed, follow the same procedure as for the IP Address in STEP 6.

STEP 8 of 10

Press the UP arrow key to get to 13: Gateway. Use the same procedure to set the Gateway as used to set the IP
Address in STEP 6 if necessary.

STEP 9 of 10

=3t Setting Metwork Statust Resuire Load

™ 4

Press Menu button to return to Offline. Press On Line to pply the network setting. It will show Msg: Setting
Network. After the setting is done, the feeder panel should read Status: Require Load.

NOTE: Write down this IP address as you will need for the software.
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STEP 10 of 10

e E—ry L
B Administrator: C\Windowmeymemeemd e | N T i

Microsoft Windows [Version 6.1.76811

Copyright (o) 2089 Microsoft Corporation. A1l rights reserved.

JC 2 U “dninistrator>ping 192.168.182.221

[Pinging 192_168.182_.221 with 32 byt of data:z

[Reply from 192.168.182.142: Destination host unreachable.
[Reply from 192.168.182.142: Destination host unreachable.
Reply from 192.168.182.142: Destination h unreachable.
Reply from 192.168.182.142: Destination host unweachable.

ics for 192.168.182.221:
Sent = 4. Received = 4. Lost = B (Bx loss>.

sers\Administratordping 192.168.182.221
Pinging 192.168.182.221 with 32 bytes of data:

Reply from 192.168.1082.221: bhytes=32 time<ims ITL=64
Reply from 192.168.182.221: bytes=32 time<1 TTL=64

Reply Eron
Reply £rom

[Ping stat

192.168.182.221:
192.168.182.221:

ics for 192.168.

time<ims
tine<lms

hytes
hyte

182.221:

TTL=64
TTL=64

Packe Sent 4, Received 3
Approximate round trip times in mill con
— —— o e

Connect the cable to the feeder and now go back to your computer cmd interface, enter "ping <IP address>" (for
here is 192.168.102.221), press Enter again. You should get response this time. If you're not getting reply as in the
picture, please contact your IT support team.

= ——
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3 Before Printing

3.1 EDGE2Print User Interface

STEP 1o0f1
G2 rint 2.2 0
File Media Nesting Variable Data  Banner  Cost ReEort OEtionsl !'
Selected Media
11001 - Matte White Paper 9 9

[ Die Cut Mode:
[7] Cut On The Fy:

Page Information : Inches

Start Position (-/+): 0.000
Media Width: 6.000
Horizontal Shift (-/+): 0.000 Apply
Gutter: 0.125
Alley: 0.125
Print:
Labels to Print: 6
Print ]

Image List Q_

Rp Romte Options & ]
‘:o © 9% © 180 © 27 C‘Rir:Mirmre
Rip Scaling Options
[T] Xwidth)  |2.000 [T] Yieight)  (3.000
Printer Settings @
Printer Status | Ready To Print/Tray1 Empty
Page Count |2
1. Toolbar 2. Preview Screen
3. Print Setting 4. Image List
5. RIP Options 6. Printer Settings
This is the interface of EDGE2Print software.
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3.2 Input IP Addresses into EDGE2Print

STEP 1 of 2

(s Setup IP Addresses = | Bl |

Printer IP Address : 0.0.0.0} Printer P Address : 152.168.102.222|

. SetupIP Addresses

Feeder IP Address : 0.0.0.0 Feeder | Address : 192.168.102.221

Save ] Save

Launch the software. This window will pop up automatically if it is the first time. Input the IP addresses for the printer
and feeder, then click Save.

File  Media Mesting Variable Data Banner  Cost Report | Options
Selected Media | Printer * | Color Registration
11001 - Matte White Paper Software » ‘ P Address |
w Preferences 3 Rewinder
(& SetupIP Add (= O S
Frinter IF Address : 152.168.102.222
Feeder IP Address : 192.168.102221
Save

If you need to change the IP address, click Options>Printer=>IP Address from the toolbar, you will get the same
window as in STEP 1.
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3.3 Changing the Color Registration

STEP 1of4

File  Media Mesting Variable Data Banner  Cost Report | Options
Selected Media | Printer ] || Color Registration |
11001 - Matte White Paper Software 3 IP Address
70[,% — Preferences  » Rewinder

Select Options>Printer>Color Registration from the toolbar.

Go to the front panel of the printer and select the Media Type and Media Weight, based on the media settings you
selected in the software library. You will want to ensure that your front panel settings and software settings are the
same so you receive the exact results that are to be expected. If you do not have an exact match with the front panel
and media library settings, there is potential for an error on the front panel.

. Color Registration Form 5: |- -

Current Cyan: 0 o+ [0 |2 1 Apply |
Cumrent Magenta: 0 =/ |0 = ' Reset }
Current Yellow: 0 o 0 B | AdoAdust |
Print Registration Plot ]
Density Adjust
[] Printer Density Adjust Before Every Job
J

A
Click Print Registration Plot.

39



STEP 3 of 4

=l - [l - 2@ =[H
< > <M B <@ ~» 3
-29 ! 29 i -29 ! 29 i -29 D 29 D
2ol = 2ol =l [0 =@
=M = - Kl | »0 =@
25! 26i 26! 76i ?GD 76D
o | 2« «0 0
=l =l = =l =0 =@
= = =l = =[] =@
=l =l =l > =0 =@
ol ol ol o0 O
il -l | w@ @
-Hl -l -@ 5
ol -l <ol ¢l @ <@
«H -l N «E «E
Sl <l <l 0 O
-l -l <l -l =@ =@
-~ 1l -l ol
o] -l | -
<M -H M -H @ @
<M -l sl -1l <@ @
Ml -1 Bl -l O -0
M -l <H -H O -mO
- -’ -l B @ +J=
~-H N -l N -0 -O
M -H -l -l @ -I
-H | H B H H
il -l ol - O -O
N HEE 0 .

The printer will print a similar page that will aid in determining the proper registration values across CMY.
IMPORTANT: Use the third page printed to determine the values.

Using a printer's loupe or best judgment, determine the best values. In this case, the correct values are as follows:
C:6 M:4 Y:0; this is because the pixels are perfectly filled within the boxes.

STEP 4 0of 4
L. Color Registration Form o (S S

Curment Cyan: 0 +/- |6 = Apply

Cument Magenta: 0 +/- & Reset

Curmrent Yellow: 0 </~ 0 = Auto Adjust

Print Registration Plot ]

Density Adjust
[ Printer Density Adjust Before Every Job

Input the values determined in the previous step and click Apply to set. NOTE: If there are troubles with the color
density, check Printer Density Adjust Before Every Job.
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3.4 Setting up the Cost Estimator

File  Media Mesting Variable Data Banner Cost Report | Options

Selected Media Printer 3
11001 - Matte White Paper | Software 2 | Caost Calculator |

Open File Preferences  » Display Options

Print Alignment

Die Cut Mode: WYariable Data
Cut On The Fly: White Tener

Click Options->Software->Cost Calculator from the toolbar.

STEP 2 of 2
s Configure Costing E

Black Toner Cost ﬁ
Color Toner Cost 227.00
Black Drum Cost 159.00
Color Drum Cost 159.00
Fuser Cost 315.00
Transfer Belt Cost 292.00

Waste Bottle Cost 0.00

Media Roll Lengthft) D
Media Roll Cost 0.00
| Save | | Cancel |

Input the price paid for each consumable. This will calculate the estimated cost per label. This value will appear in
the Image List. (Values above are examples and not indicative of the retail price paid)




3.5 Changing Units of Measurement

File  Media Mesting Variable Data Banner CostReport | Options
Selected Media Printer 4
11001 - Matte White Paper | Software b | CostCalculator
OpenFie Preferences  » | Display Options |
Print Alignment
Die Cut Mode: Variable Data
Cut On The Fly. White Toner

Select Options>Software->Display Options from the toolbar.

. Display Options l o . e S

Measurement Units

Q@ Imperial

) Metric

w
>

inches Decimal Places

mm Decimal Places 3 B

| Enable Borders On PDFs Displayed

Select your preferred measurement units to display and click Save.




3.6 Changing Borders on PDF Preview

File  Media Mesting Variable Data Banner Cost Report | Options
Selected Media Printer 3
11001 - Matte White Paper Software » | Cast Calculator
Preferences  » | Display Options |

Print Alignment

[ Die Cut Mode: Variable Data
[7] Cut On The Fy: White Toner

Select Options>Software->Display Options from the toolbar.

(&, Display Options osilE) g

Measurement Units

© Imperial

Metric
inches Decimal Places 3
mm Decimal Places 3

[V] Enable Borders On PDFs Displayed

Save

L

Check the box to enable borders on PDFs display or uncheck the box to disable.

=
N

EQ 7 IME’%‘»‘

Left one has the border enabled and right one has the border disabled.
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3.7 Measuring Your Media

STEP 1 0of 6
Page Information : Inches
Start Position (-/+): 0.000
Media Width: 2.250
Horizontal Shift (-/+): 0.000 Apply
Gutter: 0.125
Alley: 0.125

This is the interface of media page information in EDGE2Print software.

NOTE:
Gutter is the distance of the horizontal gap between labels.
Alley is the distance of the vertical gap between labels.

STEP 2 of 6

Measure the total width of paper. Input the value into Media Width.

t

Measure the distance of horizontal gap. Input the value into Gutter.

STEP 4 of 6

Measure the distance of vertical gap. Put the value into Alley.

STEP 5 of 6
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You also should measure the width and height of the label. Save the values for later.

STEP 6 of 6

Measure the right border of the label. The distance from the edge of the facestock to the edge of the should be less
than 2mm because of the sensor location on the guide.
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In order to get more precise value of gutter, there is a better way! Measure as least one meter of the media, and
measure the height of one label. Then calculate the distance of the gap. The longer you measure the media, the

more precise value you will get.

Ex. For the left picture, we measure 9 label lengths plus 9 gutter lengths; the total length is 1171.58 mm
(46.125 inches).

Then measure one label length, which is 127mm (5 inches).

Therefore, the gutter value is (1171.58/9)-127= 3.177 mm
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3.8 Loading Media for Continuous Printing

IMPORTANT: Only use with media width ranging from 6” to 8.5” wide. If use with media width less than 6",
please use a narrow fuser.

NOTE: Maximum Printable Width is 8.25”.

STEP 1 of 13

Notesecure paper roll packaging and end pieces

{
{

Unpack the media, make sure the sides of the roll are straight and flush with the core.
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STEP 2 of 13

S

Make sure the core is thicker than 4mm. If not, when the roll is running to end, it will go out of the e)Qtension arm.

If you 're using a die cut media, make sure the margin is less than 2mm. If you're using a back/top mark media,
make sure the black mark offset from edge is less than 1mm. If the margin is too large, the sensor can't read the
gap/mark.




STEP 5 of 13

Pull out the feeder tray and open the front cover.

STEP 6 of 13

’ ] \ 1
o o s
/ K - ‘
-

y V| -
Cut a small piece of the media to adjust the width of the guides.

Open the left and right media guides and place the paper between the guides. Use the width adjustment wheel to
adjust the width, making sure there is no space on both sides and the paper can pass through with no tension.

STEP 7 of 13
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Remove the plastic spindle and insert it into the core of the media roll, ensuring that you keep the edges of the roll
completely flush with the core.

Place the roll in the feeder between the extension arms, with the leading edge of the material at the bottom of the
tray. Adjust the width of the extension arms to fit the paper roll’s width, if necessary.

View #1 View #2

P
Feed the media through, ensuring it is between the tension and pinch rollers.
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STEP 9 of 13

With the media flush against the back plate in the feeder, ensure that there is no extra space on each side of the
media and the left/right media guides.

Feed the media underneath the drive roller and ensure that the paper is at the same level as the top of the rollers.
Back wind the roll if necessary.

Close the red left/right media guides. Ensure that the media is not buckling or too snug against the guides before
proceeding to the next step.

STEP 10 of 13

Close the front cover and push the tray in.
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STEP 11 of 13

—— |

Power on the printer. When the feeder displays “Status: equire Load,” press the Load button on the feeder.

The media will be fed upwards and cut the substrate, leaving a clean leading edge for printing.

STEP 12 of 13

After the feeder cuts the paper, remove the Cut on the Fly module and scrap material. Put the Cut on the Fly Module
back in position.

STEP 13 of 13

Now the feeder should read Status: Idle.
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3.9 Sensor Calibration for Die-cut Label Printing

STEP 1 of 6
| Open File l Open File l
T Sensor
[] Die Cut Mode: [¥] Die Cut Mode:
[] Cut On The Fly: @ Gap

Back

If your media is die cut, select Die Cut Mode. Then select the Sensor Type. (We will use the Gap Sensor as the
example in the following instructions.)

NOTE: If the Calibrate button is red, it means the sensor needs calibration before printing.

STEP 2 of 6

Refer to STEP 1-8 of “Loading Media for Continuous Printing” for how to load the roll of media. After the die cut roll
is loaded into the tray, line up the gap of the labels about one inch below the sensor.

Close the left/right media guides. Backwind the roll to ensure there is no tension when the sensor is calibrating. If
the roll is fully wound and has tension on it, it will skew the calibration. Close the front cover and push the tray in.

STEP 3 of 6
‘ Open File ’
e Sensor
(V| Die Cut Mode:
@ Gap
) Back

After the media is properly loaded, click Calibrate in the software.
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STEP 4 of 6
[, Calibrate Sensors X

Feeder Settings Media Library Settings
Sensor Type Gap Sensor Type Gap
Sensor Gain 228 Sensor Gain 0
Sensor Window 56 Sensor Window 255
Copy Feeder Settings To Media Library ] [ Copy Media Library Settings To Media Library J

Run Calibration

Click Run Calibration. The printer will run the paper to the nearest gap mark.
NOTE: You can use previously stored values in the feeder from the last use by clicking Copy Feeder Settings To
Media Library. You can also manually input the values for Sensor Gain and Sensor Window under the Media Library
Settings, and then click Copy Media Library Settings To Media Library to update the values in the feeder.

Status g

I L Calibration Failed

J

— — 2

If the calibration did not work, an error screen will pop up.

Adjust the roll again and make sure the gap of the label is about one inch below the sensor then perform another
calibration.

STEP 6 of 6

2 _—
After calibration is done, go to the feeder, follow STEP 9-13 of "Loading Media for Continuous Printing" to finish
loading process.

You are now ready to add a label image and print a die-cut label.
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4 Printing

4.1 Selecting a Media ID

STEP 1 of 2

File | Media Nesting

Variable Data

Banner

Cost Report

Options

Click Media from the toolbar.

STEP20f2

[, iSys Certified Media

Paper l Plastic I Foil

Glossy Il Matte ﬂ Semigloss

Tag | Texture

Piggyback I Fluorescent |

Media ID

11018 - Matte White Paper
11021 - Matte White Paper

11023 - Matte White Paper
[11024 - Matte White Paper
11025 - Matte White Paper
11026 - Matte White Paper
11027 - Matte White Paper
11028 - Matte White Paper

11001 - Matte White Paper | MAGiet Ink Jet
11018 - Matte White Paper_

11020 - Matte White Paper |

‘ 1 022 - Matte White Paper .

Media Description

Latex Impregnated RR22 3.2 mil. Hi-White Kraft
Matte Laser RP54 3.2 mil. Hi-White Kraft

54# Laser RP51 3.2 mil. Hi-White Kraft

40# Jetlite RP54 3.2 355 White Kraft (2.2 mil.)
50# Jetlaser RP54 2.8mil White Kraft

Jetcolor RP54 2.8 mil White Kraft

50# Laser Plus RP54 2.78 mil White Kraft
Jetlaser Translucent RR22 3.2 mil Hi-White Kraft A
Matte Litho RP51 40% White Kraft

Jetlaser Translucent RP54 3.2 mil Hi-White Kraft .
Fasson Uncoated Litho WS/AT20N/1.2M PET .

| MacTac

| UPM Raflatac
| UPM Raflatac

| UPM Raflatac

Media Vendor
Plain
UPM Raflatac | Plain
UPM Raflatac |

UPM Raflatac

Plain
Plain
‘ Plain
Plain
UPM Rafiatac | Plain
Plain
UPM Raflatac
UPM Raflatac
UPM Raflatac

Avery Dennison

Plain
Plain
Plain

Plain

Media Type

Media Weight
| Utra Heavy 1
Ultra Heavy 1
. Ultra Heavy 1
. Ultra Heavy 1
. Ultra Heavy 1
. Ultra Heavy 1
. Ultra Heavy 1
|Utra Heavy 1
| Utra Heavy 1
. Ultra Heévy |
Ultra Heavy 1
. Heavy 7

double click.

The media list will open. It contains medias that have been certified by UniNet. You can select one from the list by




4.2 How to Create a New Media ID

STEP 1 of 5

File MediaT Nesting Variable Data Banner CostReport  Options
To create a new media, click the Media tab on the toolbar.
STEP 2 of 5
[, iSys Certified Media
Paper | Plastic | Fo
Glossy | Matte i Semigloss | Tag | Texture | Piggyback | Fluorescent ‘
Media ID Media Description Media Vendor  Media Type Media Weight
11001 - Matte White Paper | MACjet Ink Jet MacTac Plain Uttra Heavy 1
11018 - Matte White Paper | Latex Impregnated RR22 3.2 mil. Hi-White Kraft |UPM Raflatac | Plain Ultra Heavy 1
11019 - Matte White Paper | Matte Laser RP54 3.2 mil. Hi-White Kraft UPM Raflatac | Plain Ultra Heavy 1
11020 - Matte White Paper | 54# Laser RP51 3.2 mil. Hi-White Kraft UPM Raflatac | Plain Ultra Heavy 1
11021 - Matte White Paper _403: Jetlite RP54 3.2 35# White Kraft (22mil) | UPM Raflatac | Plain | Ultra Heavy 1
11022 - Matte White Paper | 50# Jetlaser RP54 2.8mil White Kraft UPM Raflatac | Plain Ultra Heavy 1
11023 - Matte White Paper | Jetcolor RP54 2.8 mil White Kraft UPM Raflatac | Plain Ultra Heavy 1
11024 - Matte White Paper | 50# Laser Plus RP54 2.8 mil White Kraft UPM Raflatac | Plain Ultra Heavy 1
11025 - Matte White Paper | Jetlaser Translucent RR22 3.2 mil Hi-White Kraft | UPM Raflatac | Plain Ultra Heavy 1
11026 - Matte White Paper | Matte Litho RP51 40# White Kraft UPM Raflatac | Plain Ultra Heavy 1
11027 - Matte White Paper | Jetlaser Translucent RP54 3.2 mil Hi-White Kraft | UPM Raflatac | Plain Ultra Heavy 1
| 11028 - Matte White Paper | Fasson Uncoated Litho WS/AT20N/1.2M PET | Avery Dennison | Plain Heavy
In the pop-up window above, select the base media for your new media and right click on the Media ID.

STEP 3 of 5
[& Create & Update User Media . e oo

Media Selected : 11007 - Matte White Paper

Mediz 1D based on 11001 -
Media Description

Media Vendor

Media Type Media Weight

Medium Light a
Medium

Hea

(&, Create & Update User Media - - o [ S

Media Selected : 11001 - Matte White Paper

Media ID based on 11001 - iSys_New_Matte

Media Description For iSys matte roll

Media Vendor iSys

Media Type Media Weight
A Medium Light A

Letterhead Create This Media Medium

Bond

Recycled e

Fill in the Media ID, Media Description and Media Vendor, select Media Type and Medlia Weight from the list,
then click Create This Media.
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[, iSys Certified Media

e — e

Paper | Plastic | Foil | White Toner
Glossy | Matte | Semigloss | Tag | Texture | Piggyback | Fluorescent
Media D Media Description Media Vendor  Media Type Media Weight

[ 1001 Mot Whte s WAG s MacTec _Pan UaHeaw 1

- 11007 - Matte White Paper Fasson LaserCopy Jet 300/55010M/46HLF Avery Dennison | Plain Utra Heawy 1
11018 - Matte White Paper Latex Impregnated RRZ2Z 3.2 mil Hi-White Kraft | UPM Raflatac | Plain Utra Heawy 1
11019 - Matte White Paper Matte Laser RP54 3.2 mil Hi-White Kraft UPM Raflatac | Plain Ultra Heawy 1
11020 - Matte White Paper Bd#f Laser RP51 3.2 mil Hi-White Kraft UPM Raflatac | Plain Uttra Heawy 1
11022 - Matte White Paper B¢ Jetlaser RP54 2 8 mil White Kraft UPM Raflatac | Plain Ultra Heawy 1
11023 - Matte White Paper Jetcolor RP54 2.8 mil White Kraft UPM Raflatac | Plain Utra Heawy 1
11024 - Matte White Paper B0# Laser Plus RP54 2.8 mil White: Kraft UPM Raflatac | Plain Utra Heawy 1

M 11026 - Matte White Paper Matte Litho RP51 408 White Kraft UPM Raflatac | Plain Uttra Heawy 1

11027 - Matte White Paper Jetlaser Translucent RP54 3.2 mil Hi-White Kraft | UPM Raflatac | Plain Uttra Heawy 1
11028 - Matte White Paper Fasson Uncoated Litha WS/ATZ0M/1.2M PET | Avery Dennison | Plain Heavy
based on 11001 -iSys_MNew_Matte | For iSys matte roll iSys Plain Uktra Heawy 1 I

Your new media will be displayed in the list.

NOTE: UniNet provides a variety of substrates that have been rigorously tested for optimal print quality, ease of use
and consistency from the beginning of the job until the end. The iColor 700 was designed and engineered to operate
with approved consumables and certified media which ensure superior quality and resolution every time. UniNet is
not responsible for damage or consequences arising from the use of non-certified media or consumables.

P50

Paper

Matte

Media ID Media Description  Media Vendor Media Type Media Weight

s o 1101 -15ys_Now Mot For iyl (S Pan Ut e 1

baszed on 11001 -iSys_New_Matte Show Only User Media

There is an option that allows for only the new media to be displayed. Check the Show Only User Media box to
view only new/custom media IDs.
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4.3 Editing a Newly Created Media ID

& iSys Certified Media ‘ﬁc’ il

Paper | Plastic I Foil

Glossy [ Matte ‘ Semigloss | Tag I Texture l Piggyback I Fluorescent |

Media ID Media Description Media Vendor Media Type Media Weight
11001 - Matte White Paper | MACjet Ink Jet MacTac Plain Ultra Heavy 1
11018 - Matte White Paper | Latex Impregnated RR22 3.2 mil. Hi-White Kraft | UPM Raflatac | Plain Ultra Heavy 1
11018 - Matte White Paper | Matte Laser RP54 3.2 mil. Hi-White Kraft UPM Raflatac | Plain Ultra Heavy 1
11020 - Matte White Paper | 54# Laser RP51 3.2 mil. Hi-White Kraft UPM Raflatac | Plain Uttra Heavy 1
11021 - Matte White Paper | 404 Jetlite RP54 3.2 35# White Kraft 2.2mil) |UPM Raflatac | Plain Ultra Heavy 1
11022 - Matte White Paper | 50# Jetlaser RP54 2.8mil White Kraft UPM Raflatac | Plain Ultra Heavy 1
[ 11023 - Matte White Paper | Jetcolor RP54 2.8 mil White Kraft UPM Raflatac | Plain Ultra Heavy 1
11024 - Matte White Paper | 50# Laser Plus RP54 2.8 mil White Kraft UPM Raflatac | Plain Ultra Heavy 1
11025 - Matte White Paper | Jetlaser Translucent RR22 3.2 mil Hi-White Kraft | UPM Raflatac | Plain Ultra Heavy 1
11026 - Matte White Paper | Matte Litho RP51 40# White Kraft UPM Raflatac | Plain Ultra Heavy 1
11027 - Matte White Paper | Jetlaser Translucent RP54 3.2 mil Hi-White Kraft | UPM Raflatac | Plain Ultra Heavy 1
11028 - Matte White Paper | Fasson Uncoated Litho WS/AT20N/1.2M PET | Avery Dennison | Plain Heavy
S5 Pan  Heaw

iSys_new_Matte

\ J
If the new media needs to be edited, right click on the new Media ID.

STEP 2 of 2
(i, Create & Update User Media - - -
Media Selected
Media ID 1Sys_new_Matte
Media Description ForiSys matte rolls
l Media Vendor iSys
. Media Type Media Weight
T | Light 2
| Letterhead I Medium Light
|Bond ‘ Undate s Meda Megium
|Recyled | T —
Delete This Media
Error Deleting Active Media =)

\0\ You Can Not Delete The Current Selected Media

This window will allow you to edit. After editing, click Update This Media button to update the information. If you
want to delete it, click Delete This Media button.

NOTE: You can only delete the media you created. The certified medias in the library can't be deleted.
You can't delete the media that is currently been selected, or an error will be displayed.
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STEP 1 of 5

4.4 Adding Label Images to Print

File

Media  Mesting

Banner

Open

Load Page Information
Save Page Information

Exit

File Media Nesting VariableData Banner Co:
Selected Media
11018 - Matte White Paper

Open File
Sensor

V| Die Cut Mode:
@ Gap Calibrate
) Back

To open a file, choose File=>Open, or click Open File button to select your PDF file, or you can simply drag and
drop your PDF file to the Preview Screen.

NOTE: EDGE2Print uses PDF files only. Under Windows 8, drag and drop doesn't work.

STEP 2 of 5

are aligned in columns.

You can load multiple PDF files as long as they have the same dime
exceed the column numbers on the die cut media. The images will show in the Preview Screen, and multiple files
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STEP 3 of 5

Image List
Remoave | File Name Toner Cost
[ Delete | Salad_1 0.03910
[ Delete | Salad_2 0.02356
[ Delete | Salad_3 0.03384

| Clear |
The information of the images will show in the Image List on the left.

STEP 4 of 5

Print: 1.453 feet
Labels to Print: 10

| Print |

Enter how many labels you want to print. EDGE2Print will automatically round the amount of labels up to complete
a full row. Then click Print to start printing labels.

NOTE: If you loaded multiple PDF files, the copy number indicates the amount of each PDF file.

STEP 5 0of 5
Feeder Not Ready E

‘ Feeder is NOT Idle
Click 'OK' Once Feeder is Idle To Continue Printing
Or Click 'Cancel’ To Exit This Print Job

’ OK | | Cancel 1

If the feeder panel doesn't read Status: Idle, a message will show. Please go the feeder to load the media and get
the feeder to the idle status and click OK to continue printing.




4.5 Adjusting the Print Alignment

STEP 1 of4

File Media MNesting VariableData Banner CostReport | Options
Selected Media Printer 3
11001 - Matte White Paper | Software | CostCalculator
Preferences  » Display Options
Print Alignment
7] Die Cut Mode: Variable Data
[ Cut On The Fly: White Toner
Ve N
(. Print Alignment Setup | E)
Non Die Cut
Pattem Header Length 122.00]
Pattem Footer Length 22.00
Die Cut
Pattem Header Length 22.00
Pattem Footer Length 2200

Select Options=>Software>Print Alignment from the toolbar. Set the proper Pattern Header Length and Pattern
Footer Length.

NOTE: For every print job, you need to adjust vertically where the printer starts printing the label images.

Recommendation: The header needs to be 22 inches or longer in order to adjust the color registration. The footer
can be set to 0 without affecting the color registration.

STEP 2 of 4

22"

Use header
patterns to
adjust and align
labels

[T 14 "!N

Check the start position. The 22 inches of headgr color patterns are used for calibration. The gap between labels
should be in line with the gap on the label line. If the labels are not aligned after the third copy, adjust the start
position value according to how far the label is from the gap.
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STEP 3 0of 4
Page Information : Inches

Start Posttion (-/+) 0.000
Media Width 8.169
Honzontal Shift (-/+) 0.000 Apply
Gutter 0.125
Aley 0.125

Start Position
Positive Value (+): Move print down
Negative Value (-): Move print up

STEP 4 0f 4

Page Information : Milimeters

Start Postion 0.000

Media Width 210.000

Honzortal Shit (-/+) 0000 || Apply
Gutter 3.200

Alley: 3.200

We can also use Horizontal Shift(-/+) to make adjustment to the labels.
Positive Value (+): Move print right
Negative Value (-): Move print left




4.6 Nesting

Nesting is a feature where users can print multiple graphics of the same size and layout in a sequence without stopping.

For example, you have three salad labels of the same size and need 10 Mediterranean, 5 Berry Blue and 25 Field Berry
for one run. Rather than printing these individually, you can print them all in the same run, one after another without

stopping. By using the nesting feature you will save time of setting up the job and save media by using one header and
footer rather than three.

STEP 10f4
File  Media Mesting EBanner CostReport  Seb
Selected Media
11001 - Matte White Paper

Cipen File

| Die Cut Mode: Top
@ Gap Calibrate
Back

Sensor

Page Information : Inches

Start Position: 0.000
Media Width: 8500
Horizortal Shift (-/=): 0.000 Apply
Gutter: 0.125
Alley: 0.125
Print:
Labels to Print: 10 Add Edit
| Print Nesting |

Click Nesting on the Toolbar. Notice that the Add and Edit buttons have become available and the Print button is
now labeled Print Nesting.

Load the PDF file/files and enter the number you want to print. Then click Add and job will be saved for printing and
the images will disappear from the Preview Screen. The Print Nesting button will now display Print Nesting: 1

STEP 3 0f 4
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File Media Nesting Banner

CostReport  Setup Options
Selected Media

11001 - Matte White Paper

(Oeenfe |
7| Die Cut Mode i
® Gap ‘ Calibrate
Back [

3975
3175

Print:

Labels to Print: 2

[ Add Edt |

Print Nesting: 3

Image List

Clear

Repeat the above step until all the printing jobs are loaded. For example, we have 3 jobs loaded, Print Nesting: 3
will be displayed. Click that, and the printing process will start right away.

STEP 4 0of 4
. Mesting Options E
Adjustable White Space : Milimeters N
Update
Between Nested Jobs j0.000}
[ B |
PDF Name(s) Labels To Print Length
Salad_1 10 0.44
Salad_2 5 0.22
Print: 3.281 feet Salad_3 25 1.00
Labels to Print: 25 Add Edit
| Print MNesting: 3 |
If you need to edit the nesting job, click Edit button and the option window will pop up. You can add white space

between nested. Label quantity can also be adjusted across each nested job. Once the necessary changes have
been made, click Update then click Exit to return.
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4.7 How to Activate Variable Data (iVDP)

STEP 1 of4

File Media Mesting Variable Data Banner  Cost Report | Options
Selected Media Printer 3
11001 - Matte White Paper Software » Cost Calculator
Open File | Preferences  » Display Options
Print Alignment
Die Cut Mode: Variable Data
Cut On The Fy: White Toner
Select Options>Software>Variable Data.

[, Variable Data Setup l =HEC —é&-}

Dongle ID: (B - ‘

\ ,

Make sure the Dongle ID is correct and click Import.

STEP 3 of 4

Oy S < sx Niseoich ke »

New folde R o

Variable_Data_Enabled.dat

« [AlFiles

Open | Cancel

Open the folder that holds the Key and select Variable Data Enabled.dat, then seléct Open.

STEP 4 of 4

File. Media Nesting VariableData Banner CostReport Setup Options
The Variable Data tab is now on the toolbar. If not, close the software and reopen it.
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4.8 Printing Variable Data

STEP 1 of 5

File Media Nesting VariableData Banner Cos
Selected Media

11001 - Matte White Paper

([(Openfe |

V| Die Cut Mode:

@ Gap Calibrate
Back

Page Information : Inches

Start Posttion (-/+): 0.000

Media Width: 3169

Horizontal Shift (-/+): 0.000 Apply

Gutter: 0125

Aley 0.125

Print:

Labels to Print

‘ Print ‘

Select Variable Data from the Toolbar. The Labels to Print option now becomes unavailable.

STEP 2 of 5
G EDGEZPrint R2206

?lera &

File  Media
Selected Media
11001 - Matte White Paper

[ Open Fie

[ Die Cut Mode:

lesting | Variable Data | Banner

Tauna

Garden Center

Tauna

Garden Center

Tlora &

Page Information : Inches
Start Posttion (-/+)

Media Width:

Horizontal Shift (-/+):
Gutter:

Aley:

0.000
8.500
0.000
0.125
0.125

[ oy |

English Daisy

Print: 1.858 feet

Labels to Print

Pl Haght &

Image List

5963

Price: $7.99

1503053

Brown Eyed Susan

Heght 3240

- 5963

Pri

ce: $2.99
03054

15(

Remove File Name loner,

Cost(Est)
003432

Flora10

tTIora &

Tauna

Garden Center

tflora &

Tauna

Garden Center

Clear
Rip Rotate Options

@0 S0 180 270 Rip Mimor

Rip Scaling Options

V] Xiwidth)  3.453 [¥] Yheight) 4333

Printer Settings
Printer Status | Ready To Print/Tray 1 Empty

Page Count

into separate jobs of 1.9GB each.

Open the PDF file that contains your variable data. Once loaded, click the Print button.

Important: If only the first image of your variable data is visible on the preview screen, then you did not click the
Variable Data tab before you load the file. You should clear the file and redo STEP 1 & 2.

Limitations: Variable Data has a 1.9GB limitation. If the file is larger than 1.9GB, the software will divide the data
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Variable Data Processing

RIP Processing PDF Page 12 /12
Separations Processing 12 /12
Estimated Job Size 20 Megabytes

‘ Printing Job #1

Once the Print button is clicked, this window will pop up. The RIP and Separations Procession will take a while to
fully process depending on your hardware. Once they have processed, their screens will turn green and a Printing
Job #1 will appear.

STEP 4 of 5

Variable Data Processing
RIP Processing PDF Page 48 Of 43
Seperations Processing 48 Of 48
Estimated Job Size 134 Megabytes
Job #1 Contains 6 Labels

[mee ) [ |

If the print job is larger than 1.9GB, and you selected Pause between 1.9GB print jobs option, this window will appear
after the first job is printed and you must click Print Job #2 to start printing the next job. If you did not select Pause
between 1.9GB print jobs, then job #2 will automatically start printing. Please refer to STEP 5 for printing options.

STEP 5 0of 5
File Media Mesting Variable Data Banner  Cost Report | Options
Selected Media Printer 3
11001 - Matte White Paper | Software " | Cost Calculator
Open File Preferences » Display Options

Print Alignment

Die Cut Mode: | Variable Data
Cut On The Fly: White Toner

T = )
(L, Variable Data Setup L‘:’—E’Jﬁ

Dongle ID: 18

Printer Output Processing
Aways Vercally Processing
© Aways Horizontal Processing
Always Ask

Pause Before Printing

[

Printing Options l
|

Pause Between 1.9 GB Print Jobs ‘

|

Generate Cost Report After Printing

Click Options->Software->Variable Data from the toolbar, you will see the Options of variable data printing.




4.9 Printing Using Banner Mode

STEP 1 0of 5
File Media MNesting Variable Data Cost Report  Options

Selected Media
11001 - Matte White Paper

[] Cut On The Fy:
EDGEZ2Print has a feature which can print a long PDF file using the banner mode.

Select Banner from the toolbar. The Die Cut Mode now becomes unavailable.

STEP 2 of 5
[ EDGE2Print R2.205 [E=EEER

File Media Mesting Variable Data | Banmer  CostReport  Setup Options
Selected Media
11001 - Matte White Paper

[ Cut On The Fy:

»

n

Page Information : Inches

Start Postion: 0.000 o
Media Width: 2268

Horizontal Shift (=) 0.000 Apply
Guter: 0.125

Alley. 0.125

Print: 6.188 feet
Labels o Prirt. 2

Print

Image List

Remove  File Name Toner Cost
| Delete || ThisSideUp_long 0.73210

Rip Rotate Options
@0 ©9% © 180 @20 Rip

neight) (4333

Prirter Settings
Printer Status  |Ready To Print/Power Save

Pags Court [0

Load :[he PDF file into EDGE2Print.
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PDF/Label Size Mismatch g

(’ﬁ‘) File Name : ThisSideUp_long.pdf
&Y Media (200.000 x1320.800)
PDF (101.600 x 1346.200)

If this dialogue pops up, it means you did not click the Banner tab before you load your file. Please redo STEP 1
&2.

STEP 4 of 5

Page Information : Milimeters

Start Posttion: 0.000

Media Width: 304.800

Horizontal Shift (-/+): 0.000 m
Gutter: 50.000

[Alley:

& EDGE2Priet R2205

| File Media Mettng Vanable Data
Selacted Mada
11001 - Matte White Paper

Open Fle

St Postion 0.000
Moda Wiah 304 200
Morzortal St (/) 0.000
Guster 50000
Hey. 20000

Lasbels to Part -]
77;1

mage Lt

Remove Fle Name

If the media width is large enough to take up multiple columns of the banner, it will show in multiple columns. You
can set a value to the Alley to separate each column.
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STEP 5 of 5

Page Information : Milimeters

Start Posttion 0.000

Media Width 304.800

Honzontal Shift (-/+) 0.000 Apply |
Gutter. 50.000 |

Alley 20.000

th

THIS END
UP

gy

You can set a value to Gutter if you want a gap between multiple banners. The output of your banner will look like
the layout above.

NOTE: The limitation of PDF size is 200 inches (5080 mm) long. If your graphic is larger than this, you will need to
have your graphic designer create a multi-page PDF with 199 inches (5054.6 mm) sections or less. The multi-page
PDF can now be imported into the software and printed in sequence.
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4.10 How to Activate White Toner

EDGEZ2Print allows you to print white spot color and print white underneath the color for transparent media and black
media.

STEP 1 of 7

Share with » Burn MNew folder

|#| EDGE_White.icc
n | Install White ICC.exe

Install the ICC profile for using white toner first.
Open the folder of Install White ICC. Double click Install White ICC.exe.

STEP 2 of 7
8 Install ICC for White Toner (5] (=l e

Click to Install
White ICC for

EDGE !

Click the button Click to Install White ICC for EDGE!

STEP 3 of 7
aid Install ICC for White Toner =1 =) [ ("o nstal 10 for White Toner |l (51 bl

DONE!

Click to Exit

Wait until the process finishes. Close the window by click the center button.

STEP 4 of 7
File  Media MNesting Variable Data Banner  Cost Report W‘_
Selected Media Printer b
11001 - Matte White Paper Software » Cost Calculator
Open File | Preferences  » Display Options
Print Alignment
Die Cut Mode: Variable Data
Cut On The Fy: White Toner

Go to Edge2Print, click Options->Software->White Toner from the toolbar.
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[, White Toner Activation ! - | (=] i‘z-l
‘ Import
Dongle [E chnse
Click Import License.

(& Open g

. -
@\Jvl <« Clarissa (E) » White Toner ~ [ 4 || Search white Taner ol

Organize v New folder e 0 @

¥ Favorites “  |[E) White_Toner_Enabled.dat
B Desktop
5| Recent Places
CloudStation
¥ Dropbox
| iCloud Photos
& OneDrive

B Desktop
4 Libraries
% Homegroup

2 Administrator

File name: White_Toner_Enabled.dat M

Open the folder that holds the Key and select White_Toner_Enabled.dat, then select Open.

STEP 7 of 7
File Mesting  Variable Data  Banner  Cost Report  Options

Ly iSys Certified Media

Paper | Plastic | Foill | White Toner

Plastic || Faper

Media |D Media Descrption  Media Vendor  Media Type  Media Weight

5000 -Gloss Car PETfor W TBD 8D Pan U a1

Now, click Media from the toolbar, you will see a White Toner tab with two categories Plastic and Paper.




4.11 Printing using White Toner

(s iSys Certified Media

Paper | Plastic | Foil | White Toner

Plastic || Faper

Media 1D Media Description  Media Vendor Media Type Media Weight

5001 - o Cea PETfor Wi T8 T80 Fan |Ukaean |

Selected Media
50001 - Gloss Clear PET for White W

Media for White T Selected
Open File | edia crI ite Tener Selectec h

Select a media under White Toner category. You will see a "W" on the right side of the media name which indicate
that the media for using white toner is selected.

STEP 2 of 2

£ EDGE2Print R22.06 i Y [E=gEEESE)

File Media Nesting VariableData Banner CostReport Options
Selected Media
50001 - Gloss Clear PET for White w

Open File

[C] Die Cut Mode:
[ Cut On The Fy:

m

Page Information : Inches

Start Position (-/+): 0.000
Media Width: 8.500
Horizontal Shift (-/+): 0.000 Apply
Gutter: 0125
Aley: 0125

Print: 1.115feet
Labels to Print: 6

1 Print ]

DI pefes
A119g ppLy

I peres
A119g pp1y

Image List

Remove File Name Toner Cost

Salad_3 0.07134

Clear

Rip Rotate Options
90 %0 © 180 © 270 [T Rip Mimor
Rip Scaling Options

[] Xwidth) ~ 3.453 [¥] Yheight) 4333

Printer Settings
Printer Status | Ready To Print/T

Page Count

DI pefes [ .

The printing process for white toner is the same as the normal one. It works for regular, nesting, variable data and
banner modes.
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Using Spot White

NOTE: If you want to print white, the color MUST be spot White. The following is an simple instruction to change a
color to spot White color in Al.

STEP 1 of 4
I Fle 6t Object Type Seoct Bt View E g
|| o swncten n Seehe § 1pt - X, ,
_ Apex u‘mmr-nxunmnr .:lm ;(uvmm-l- Worspece ’
m *.E * + + ; Extensions » 3 *
,; &,: ; — V] o L4 |
\: _,:; Tools - |
7.1 Actions
& a4, Algn [ v |
0.9.1s Appesance P e
'\‘l: i:i. | Anbosds SWATOSES |
\,&J_v Astrbutes CeF11 .
agl = : -
5 |2 Color Guide Shive i3
3;"'_ Decument Infe
y *'T Flattener Prevew — P e
" | Grachert Cui-/9
| o ] —
3 [ wto Cuiefe ‘"m“c —
2 z || ——
=ik RN\ | 3
Open you file in Al. Cllck Wmdow->CoIor and Window->Swatches to show COLOR and SWATCHES windows.

STEP 2 of 4

MV Acetone-Free

340ml /

/

(L erssaonner V| o, /

Select the area you want to print white, then double click White on SWATCHES.
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STEP 3 of 4

SWATCHES
/4

¢ COLOR

C————mm o
Qu::: °
VE:::::::::::::::: 0
‘ X o

e ER

Swatch Name: White @
a Color Type: Process Color I Cancel
Process Color

‘ SwtCoor |
\ ) Color Mode: CMYK - Bt
\ | C ——=m %
\ / M= %
rm—— ’ 3 0 x
R4 ‘ Acetone-Free / s : .
T S —
\M Congort Apphes j’

L

Change the Color Type from Process Color to Spot Color. Then click OK.

NOTE: Make Sure the Swatch Name is "White"ll It is very Import!

STEP 4 of 4

SWATCHES

G, % B8 O a3 3

| Acetone-free
L “Ss0m
.7 a7

2,4 arex1 0
L STSSA08T | Compase supplies

Now you have spot white for selected area. You can tell from the COLOR window which shows White 100%. Repeat
Step 3 and 4 for all area you want to be spot white and save the file.
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4.12 How to Set Up the Rewinder

STEP 1 0of 6

Loosen the Core Adjustment Knob. Place a core on the Rewinder Spindle. Make sure the core is the same width
of the media you're printing on or slightly smaller. If the core is the exact same width as the media, ensure it is placed
flush against the left end disk. If the core is slightly smaller, place it in the center using your best judgment.

STEP 2 of 6

sk il ST
Cut a section of the media you’ll be using to print. Place that piece of media flush against the Left End Disk and
adjust the Right End Disk to fit the media. Ensure that the paper is flat against the core and there is no excess
space on each side of the End Disks. Tighten the Core Adjustment Knob.

NOTE: If there is excess space between the core and the Left/Right End Disks OR the media is not flat against the
core, it will cause the roll to wind haphazardly, not wind tightly and create bubbles in the roll.
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STEP 3 of 6

Loosen the Lockdown Knob for positioning. When you are ready to print, send a small section of labels to the
printer. While the section is printing, adjust the rewinder left/right using the Width Adjustment Knob, aligning the
rewinder with the paper path as the labels exit the machine. Once the paper path and rewinder are aligned, tighten
the Lockdown Knob.

STEP 4 of 6

Plug the DC Power In, and then plug the end of the power cord into a socket. Turn the rewinder on by turning the
switch to REV.
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STEP 5 of 6

i \ v
Press Print in the software when your job is ready. As the paper exits the printer, lift the Dancer Arm and bring the
media underneath the Dancer Arm and up onto the core. Secure it to the core using a section of media or excess
label.

Lower the Dancer Arm downwards to begin winding the material onto the core. Place your hand gently on top of
the core to create some initial tension at the beginning of the roll. Once the media is winding, release the Dancer
Arm gently downwards onto the paper. The roll will continue to wind.

NOTE: Winding speed is determined by the position of the Dancer Arm. Lowering the arm will speed up the winding
and lifting upwards will slow it down.

NOTE: If the roll seems to be winding too loosely, place your hand on the top of the roll while it's winding. This will
increase the tension momentarily. Be careful when doing this as too much tension will cause the roll to wind unevenly
or create bubbles between the reams.

STEP 6 of 6
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When the roll is done, turn off the rewinder. Unscrew the Core Adjustment Knob on the Spindle. Remove the roll
from the Spindle and return the Right End Disk to its initial position.
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5 Software Features and Options

5.1 How To Print a Full Bleed Die Cut Label

The following is a detailed guide to create an oversized label image on top of a die cut label. The term over bleed
means that there is a small portion outside of the actual label known as the “overprint area”. Excess toner of the label
is printed on to this area so that the actual dimensions of the label are met with clear, clean cut edges. The cutting is
done after we print.

WARNING: Print full bleed die cut label may damage the consumables!

Label Label ” “ Label
Label Label Label
Label |H| Label Label
Label Label Label

STEP 1 of 3

Width

Gutter

t

Measure the label length, label width, gutter and alley.
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STEP 2 of 3

Page Information : Milimeters

Start Position: 0.000

Media Width: 215,500

Horizontal Shift (-/+): 0.000 |T|
Rip Scaling Options Gutter: 3175 -
V] Xjwidh) 50500 (4] Yheht) 127000 @ AV 3175

Input the number into proper place. For example, the label width(X) is 50.5mm, label height(Y) is 127mm, gutter is
3.175mm, alley is 3.175mm.

STEP 3 of 3

Page Information : Milimeters

Start Position: 0.000

Media Width: 215.900

Horizontal Shift (-/+): 0.000 Apply
Rip Scaling Options Gutter: 1175
7] Xjwidth) 52500 7] Yheicht) 128000 U 1175

If you want to print Lmm bleed outside of the label size on both direction, just minus gutter and alley by 2mm, and
add 2mm to width and height. So width becomes 52.5mm, height becomes 129mm, gutter becomes 1.175mm and
alley becomes 1.175mm.




5.2 Install Your Own ICC Profile

STEP 1 of 8

Selected Media N
based on 11001 -iSys_MNew_Matte |' |

Selected Media
based on 50001 -iSys White W r

When you are using the created media, you can install your own ICC profile. Click the colourful square button on the
right side of your media’'s name.

NOTE: If the media is created under white toner category, you don't have the color management option.
TIP: If you have a three-column media and you want to compare three different color managements on the same
sheet, you can do like this. Choose one ICC profile for your label, load it into the software. Choose another ICC

profile, load the same image into the software. Repeat this one more time, and click print, then you will have three
columns of the same label but with different ICC profiles.

STEP 2 of 8
a5l RIP ColorPro Setup Form = | ) [

Gurrent Media Color Options Bounding Box [ sove | [ Concad ]
Scftware Wil Leave RIP Unadiusted ®) MediaBox ArtBox
Only Apply Linearization BleedBox CropBox
© Apply ICC Profle with RIP Setup Opions TimBox
ColorPro Options

Avaizble Output Profiles
Install Qutput ICC Profile

ICC Name ICC Intemal Name B
APEX_Generalicc APEX_Generalice
APEX_Legacyice APEX_Legacy e
Commercial A Linear %dot on fim
] EDGE_Generalic EDGE_Generalicc
Fogra 3L Fogra 3L
Fogra £3L. Fogra 43L
GRACol (CGATS TRODS) GRACol (CGATS TROD6)
[5-7%7] IEDA et =2
Rip Setings
Input Profile Setting Output Rendering Intents
[¥] Color manage gray 2s CMYK Main intent iSys -
Treat spot colors as CMYK iSys Rendering Options
] Use Pantone PLUS Style Absolute Colorimetric + Black Generation  Mazdmum -
Maxmumink 200 - Blackthreshold 9.0
Input Document Cortrols
Ovenide color managemert in job = ) ed 00
Simulate paper color of job -
blue {} yelow 00
] Preseve 100% process biack
Overide overpint mode injob daker 0] ighter 0.0
V] Overpint process colors
Drop White Objects
7] CMYK 5 -
Overprint grays =l
V] -
¥| Qvemrint gray images pCE aes 55
S —— Use black point compensation
Outpus Cortrols
Use late color management Lighting Graphic Arts D50 -
Color adjustments:  Faster -

This dialogue allows you to setup your own color information. Make sure you checked Apply ICC Profile with RIP
Setup Options.
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STEP 3 of 8

Available Output Profiles

ICC Name
APEX_General icc
APEX_Legacy.icc
Commercial A

Fogra 351
Fogra 43L
GRACol (CGATS TRODE)

IED A 901

| Install Output ICC: Profiie

ICC Intemal Name:

APEX_Generalicc
APEX_legacyicc

Linear %dot on fim
EDGE_General icc

Fogra 35L

Fogra 43L

GRACol (CGATS TROOG)

ICOA 21

m

Click Install Output ICC Profile.

& () m[m oesitop [ %3 ][ Search Desktop £l
Organize v Mew falder 1 @
o
Favorites ‘wb tem Folder
B Desktop L
3 Administrator
Download:
S IR system Folder
&l Recent Places 3
Cloudstation Computer
N sycvem Folder
4 Libraries ]
5 b e =
| Documents Network
& Music .g/ System Folder
) Pictures | ICC_Through PS.icc
B videos l 4 P
Filename: 1CC_Through_PS.icc - \(*iu) '\
[~

STEP 4 of 8
o Open ===

Select the ICC profile, click Open.

STEP 5 of 8

o5 ICC Name and Comment

Change ICC Name |
Change ICC Comment

14001 Cream Textured_opticc

‘ Save |

Change the ICC name and ICC comment if you need, then click Save.

STEP 6 of 8

Available Output Profiles

CC Name

7| EDGE _General i
Fogra 9L
Fogrs 431

IFRA 261
IFRA 30L

| Install Output ICC Profile

ICC Intemal Name
cc EDGE_Generalice
Fogra 39L
Fogra 43L

GRACol (CGATS TRODE) GRACol (CGATS TROOG)

14001 Cream Textured_opt icc
IFRA 261
IFRA 30L

Thin enfile in e imbnmAnd fne sinm in Denan aobhetine

m

Then your ICC profile appears in the list.
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STEP 7 of 8
Invalid ICC Profile Type E

y - | Device/Profile Class = prtr
'S’ Color Space Signature = RGB

Notice that only CMYK ICC profile can be installed. If it is a RGB ICC profile, this window will pop up.

STEP 8 of 8

Curment Media Color Options Bounding Box: | — | | —— |
Software Will Leave RIP Unadjusted MediaBox ArtBooc
Only Apply Linearization BleedBox CropBox

@ Apply ICC Profile with RIP Setup Options @ TrimBoo

After making changes, click Save to save and close the dialogue.




5.3 RIP Settings

STEP 1 of 2

Selected Media N
iSys_new_Matte |' |

EDGEZ2Print has a feature to customize RIP settings for your labels if using own created media other than those
under White Toner category.

Click the colourful square button on the right side of your media's name.

STEP 2 of 2
adl RIP ColorPro Setup Form = [ ) ]

Curent Media Color Opfions [ swe | [ conca ]
Software Wil Leave RIP Unadiusted
Only Apply Linearization

© Apply ICC Profie with RIP Setup Options

ColorPro Options
Available Output Profiles
Install Output ICC Profle

ICC Name ICC Intemal Name o
Commercial A Linear %dot on fim
| EDGE_Generalicc EDGE_Generalicc =
Fogra 35L Fogra 35L
Fogra 43L Fogra 43L
GRACol (CGATS TRODE) GRACo! (CGATS TROOE)
IFRA 261 IFRA 261
IFRA 30L IFRA 30L
linooe Thin cenfiln in anh:intandad faesinn in Dennn aolihotinn S
Rip Settings
Input Profile Setting Output Renderng Intents
¥| Color manage gray as CMYK. Main intert iSys -
Treat spot colors as CMYK 5ys Rendering Options
] Use Pantone PLUS Style Saturation - Black Generation  Maximum -
Madmumink 200 - Blackthreshold  90.0
Input Document Cortrols
Overide color management in job == {J red 00
Simulate paper color of job -
blue {J yelow 0.0
U] Preserve 100% process black
Overide averprint mode n job darker U lghter 0.0
] Ovemrrt process colors
Drop White Objects
V] CMYKimages  iSys -
Overprint grays
V] -
] Overprint gray images B o <=
Overpet 100 biack Use black point compensation
Output Controls
Uss Iats color management Ughting: Graphic Ats D50 -
Color adjustments: ~ Faster -

Click Apply ICC Profile with RIP Setup Options on the top and you will see RIP Settings on the bottom. You can
customize your RIP settings and click Save to save them.

NOTE: To apply the settings to your label images, you have to remove your file from the list and make the change
of the setting, then reload the images again.




STEP 1 0of 9

5.4 Installing the Fonts in the RIP

@\JG‘ » Computer » Local Disk (C:) » Windows » - | +4 ‘ | Sear) jel
Organize » 7l Open Share with = Burn Mew folder =~ 0 @
[ Favorites = R ’ Type =
Bl Desktop addins Filefolder |
4 Downloads AppCompat File folder
"\ Recent Places L AppPatch File folder
CloudStation 3 assembly File folder
Boot File folder
d Libraries Branding File folder
| Documents CsC File folder
-‘ Music Cursors File folder
| Pictures debug File folder
E Videos diagnostics File folder
DigitalLocker File folder
i& Homegroup Downloaded Program Files File folder
ehome File folder
'8 Computer en-US File folder
£|="v Local Disk () 4 Fonts File folder
a Clarissa (E) Globalization File folder =7
o Release Misvserver) (R ad < n L
Fonts Date modified: 01/10/2014 2:19 PM
]‘A Filefolder Date created: 13/07/2009 9:20 PM

Go to Computer->Disk(C:)>Windows, double click Fonts.

STEP 2 of 9

o

@-v-vl A * Computer » Local Disk (C:) » Windows » Fonts »

< [ | search Farts 5

Control Panel Home

Font settings

Preview, delete, or show and hide the fonts installed on your

Get more font information

online
Adjust ClearType text
Find a character

Change font size

See also

Text Services and Input
Language

Personalization

computer
Organize +
Abg
Academy Aharoni Andalus
Engraved Bold Regular
LET Plain
Medium
Abg
Arabic Arial Arial
Typesetting Unicode
Regular M5 Regular
Ay Abg Abg
Blackletterd Book Bookman
86 BT Antiqua Old Style
207 items

A

Angsana AngsanallP
New C
Abg
Arimo Batang

Regular

G Abg
Bookshelf Broadway
Symbol 7 BT Regular

Aparajita
BatangChe
Regular
Browallia
Mew i

Press Ctrl+A to select all of the fonts within the folder, and press Ctrl+C to copy all of the fonts.
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STEP 3 of 9

E=REE=
@-u-vl + myFonts - |4¢| | Search myF... O |
Organize = Include in library « Share with - Burn Mew folder =~ 0 @
- Favorites = Rams ’ Type -
Bl Desktop 1 85f874.fon 0/ Font file
4 Downloads 1 85f1255.fon 10 Font file
%l Recent Places 1 1 85f1256.fon 10 Font file
CloudStation 3 1 85f1257 fon 1 Font file
1 85s874.fon 1 Font file
= Libraries s | 8551255.fon 1 Font file
| Documents 1 8551256.fon 10 Font file
, Music s 8551257 fon 10 Font file
k= Pictures o 8514ficfon 1 Font file
E Videos | 8514fixefon 1 Font file
+ | 8514fing.fon 1 Font file
#d Homegroup | 8514fir.fon 10 Font file
| 8514fidt fon 10 Font file
"M Computer + | 8514oem fon 1 43 PM  Font file
.‘;‘. Local Disk (C:) + | 8514ceme.fon 1 243PM  Fontfile
a Clarissa (E:) + | 8514ocema.fon 0/ Font file s
La¥ Release Miisuserver] (R | < L d
552 items
\ J
Create a new folder in a convenient location (e.g. a folder named myFonts on the Desktop), then press Ctrl+V to
paste all of the fonts into this folder.

STEP 4 of 9

Windows Explorer 3
Visual Studic 2012 »
Motepad 3
Internet Explorer 3

Adobe Acrobat X Pro »

SRIPEN] X M

iSys
—
E" OpenOffice.org Calc 2
'-’ Microsoft Office Visio 2007 2
@) Microsoft Visual Studic 2008 3

Open Windows Start and find UniNet RIP, click to open the software.
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iSys RIP |—l

iSysRIP  Edit Colov Output Fonts

jJﬂEJJﬂJJJJJJj

Installed font ‘Utsaah-Bolditalic' in TrueType format.
Installed font ‘Utsaah-ltalic’ in TrueType format.
Installed font ani' in TrueType format.

Installed font *Vani-Bold' in TrueType format

Installed font erdana' in TrueType format

Instalied font "Verdana-Bold' in TrueType format
Installed font "Verdana-ltaic' in TrueType format
Installed font “Verdana-Bolditalic' in TrueType format.
Installed font Vijaya' in TrueType format

Installed font Vijaya-Bold' in TrueType format.
Installed font “Vrinda' in TrueType format.

Installed font “Vrinda-Bold' in TrueType format
Installed font "Webdings' n TrueT ype format
Installed font "Wingdings-Regular' in TrueType format
Installed font "Wingdings2' in TrueT ype format
Installed font "Wingdings3' in TrueT ype format.
Installed font ZwAdobeF” in TrueType format.
Installed font JokermanLetPlain' in TrueT ype format.
Installed font JohnHandyLetPlain' in TrueType format.
Total time: 2 minutes 21 seconds (00:02:21.792)
Job Completed: fontlist

Preview

Click the Red Stop Light Icon to pause the program.

STEP 6 of 9

iSys RIP

iSysRIP  Edit Preview Color Output

i 415 e i)

Installed font 'Utsaah-Boldltalic' in TrueType forme
Inztalled font ‘Utsaah-ltalic' in TruaType format.
Installed font "Yani' in TrueT ppe format

Inztalled font "Yani-Bold' in TrueT ype format,
Installed font "Yerdana' in TrueT ype format.
Inztalled font Yerdana-Bald' in TrueType Format.
Installed font "Werdana-talic' in TrueT ype format,
Installed font Yerdana-Baolditalic' in TrueT ype format.
Installed font "Wijaya' in TrueT ype format.

Installed font iaya-Bold' in TrueT ype format.
Inztalled font Wrinda' in TrueT ype format.

Installed font "Yrinda-Bold' in TrueType format.
Inztalled font "wiebdings' in TrueTupe format.
Installed font "Wingdings-Regular' in TrueType format.
Installed font "wingdings2' in TrueT ppe format.
Installed font "Wingdings3' in TrueType format.
Inztalled font ZwibdobeF" in TrusT ype format,
Irstalled font JokermanLetPlain' in TrueType farmat.
Installed font JJohnHandyLetPlain' in TrueT upe format.
Total time: 2 minutes 21 seconds (00:02:21.792)

Job Completed: fontlist

Install Fonts...

| =1 -

List Fonts |

Proof Fonts...

Delete Fonts...

m

Click Fonts=>Install Fonts from the toolbar.

STEP 7 of 9

Install Fonts

Lock in: Bl Deskiop

-l Libraries
h&Homegroup

A Administrator
/M Computer
E‘I_ll Metwork

myFonts

File name:

Install

- | | Cancel |

Fies oftype: [ All Fort Fles ("pfa;" pfby” off " tte;" )

Find the new folder you just created which has all of the fonts. Double click to open.
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STEP 8 of 9

Install Fonts E
Look in: myFants - & ¥ = B
MName = Date modified i

o | 21205 TTF 31/12/1997 9:54 AM

« 35181 TTF 31/12/1997 9:54 AM

o 40240 TTF 31/12/1997 9:56 AM

« 46152 TTF 31/12/1997 9:54 AM

« 50416 TTF 31/12/1997 9:58 AM -
Fl 1 3
File name:  "35191__TTF" "40240__.TTF" "46152__TTt
Files of type: |AII Font Files (*.pfa;” pfb;"otf " ttc;” tif) v| | Cancel |

Press Ctrl+A to select all of the fonts, and click Install.

STEP 9 of 9
iSys RIP =HA= E

iSysRIP Edit Preview Color Output Fonts

i 415 4 W 3 s s

Warning: font ‘Utsaah-Bold' already exizts on disk. %% -
Warning: font ‘Utsaah-Boldtalic' already exists on disk. [2%

‘wiarning: font 'Utzaahr/talic’ already exists on disk. J%%

‘wiarning: font Wani' already exists on disk. J%%

Wwarning: font Wani-Bold' already exists on disk.
Warning: font Werdana' already exists on disk.
Warning: font “erdana-Bold' alieady exists on disk. %%
Warning: font “erdana-ltalic' already exists on disk. [%%
Warning: font “erdana-Balditalic' already exists on disk. %%
‘wiarning: font “ijapa' alreadp exists on disk. J%%

wiarning: font “Vijapa-Bold' already existz on disk. J%%
Warning: font Wrinda' already exists on disk, [%%
Warning: font "rinda-Bold' already exists on disk. 1%
Warning: font "Webdings' alieady exists on disk. %%

i

Warning: font "Wingdings-Hegular' already exists on disk. |22
wiamning: font "wWingdings2' alieady exists on disk. J2%
wiarning: font "wWingdings3' alieady exists on disk. J%%
Warning: font ZwihdobeF" already exists on disk, J%%
Wwarning: font \lokermanLetPlain' already exists on disk, [%22%

TS B B R B P8 B B B B BB B B
vty g L g L g vl g g

o

tal time: 2.713 seconds (00:00:02.713)
Job Campleted: fontlist

m

The fonts will start to install to the RIP. Once the job has been completed all of the fonts will be available in the
EDGEZ2Print Software.
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5.5 Rip Rotate Options

STEP 1of1

Rip Rotate Options
70 @9 @ 180 & 270 ("] Rip Mimor

: BERNELLOS BERNELLOS

SOT1INYI]

Olivecil Ohveoil

SOT11INYY

A
2 !

\}}
BERNELLOS BERNELLOS

W ExtaVigh = W ExvaVign = ( ~‘.
Obivesil OBvesil ‘@

!l- ! : “:- .§~
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When the Rip Rotate Option is set to 0 all PDF files will preview in their original orientation. The Rip Rotate Options
will allow for the desired orientation. For example, if you check 90 in the RIP Rotation Option, the image will rotate
90 degrees clockwise.

To rotate the graphic, first you will need to clear it from the EDGE2Print software, select the desired rotation, then
re-import the graphic.

Adjustments can now be made in the Page Information Section for correct placement on the selected media.

NOTE: If the graphic does not fit the width of the media when rotated, a red error will show on the Image List.
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5.6 Rip Scaling Options

STEP 1o0of 1
Rip Scaling Options

V] Xiwidth) 2618 V] Yheight) 4232
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If the size of your image is not the same as the label size, you can use the RIP Scaling Option to adjust it. Input the
width of label into X(width) and put the height of label into Y(height).

Select the desired scaling values, then select Clear in the Image List section. Re-import the graphic into the
EDGEZ2Print software. The Preview Screen will now show the graphic scaled according to your specifications.

NOTE: When scaling an image, some resolution may be lost and result in pixilation. If this is the case, consult your
graphic designer and have them properly scale the image rather than using the Scaling feature.
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5.7 Bounding Box Option

STEP 1of4

Selected Media N
iSys new '

The software offers option to use different bounding box for your PDF file to print. First, select a user defined media,
then click the colourful square.

STEP 2 0of 4

2 RIP ColorPro Setup Form R

Curment Media Color Options Bounding Box Save Cancel ‘

Software Will Leave RIP Unadjusted © MediaBox AttBox
@ Only Apply Linearization
Apply ICC Profile with RIP Setup Options

BleedBox
TrimBox

On the right side, ybu will see the Bounding Box option. Select the bounding box you want to use and click Save.
The default set is MediaBox.

STEP 3 of 4

(G EDGEPrintR2205 o o i e =B %

File Media Mesting Variable Data Banner CostReport  Setup Options
Selected Media -
121

Open File

[T] Die Cut Mode:
[] Cut On The Fy:

bl

2043580

inj asvm
g R WD M.

sadans asodusy
osTIXHY
e TR ERdR WU S
e ——
B6ZIXAY

0709l £Lr0P sbpars g i
"t s ey
gy ey Bumepedio peulo
0% 091 £L#02 SBYAAS 013 AAI
"t s g
R TR p—y

Page Information : Inches

Start Position: 0.000
Media Width 6.500
Horizontal Shift (-/+); 0,000 Apply
Gutter: 0.125
Aley: 0.125

Print: 3.497 feet o o
Labels to Frint: 10

l Prirt N )

Image List o =

Remove File Name Toner Cost

Delete | Apex_Tapas(8.27%3.15) 0.06956 J D J )
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Rip Rotate Options M
50 @90 © 180 © 27 [ Rip Mimar ) : ]
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Frinter Settings “l“ ‘l“l”
7R3t 33

Printer Status | Ready To Print/Power Save

[T Xtwidth)  |4.000 [7] *iheight)
01093212 7 1010'@93212”

i

Page Count

Then load your PDF and print your‘job. This is the PDF ;vith—Medi:';lBox.
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This is the same PDF as the one above with TrimBox.
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5.8 Saving and Loading Page Information

File | Media Mesting

Wariable

Open

Load Page Information

| Save Page Information

Exit

(s Save As - g

O

& Downloads E
| Recent Places

CloudStation

4 Libraries
¢ Documents
@' Music

=/ Pictures €

» Page v | 5 |[ searcn Page ol
Organize v New folder - 9
r- Favorites 2 Name Date modified Type
Bl Desktop

natch your search

File name: [EFTRNGY

Save as type: {AII files (*.%)

)

“ Hide Folders

‘ Save Cancel ]

| |

Click File->Save Page Information from the toolbar. The current page information in the software will be saved.

File | Media Mesting

Variable

Open

| Load Page Information

Save Page Information
Exit

STEP 2 of 2
(. Open - E

» Page

SS9

v|¢, H Search Page

Organize v New folder

-
- - Name
¢ Favorites %

Bl Desktop

& Downloads

|_| page_info

= Recent Places
CloudStation

4 Libraries
<| Documents
,‘ Music
=/ Pictures
B videos

<

File name: page_info

Date modified Type

29/09/2014 9:39 AM  File

i »

-

' Open lv] [ Cancel J

before, and then click Open.

To load the saved page information, click File=>Load Page Information

. Select the page information file you saved
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5.9 How to View Cost Estimation Report

From EDGEZ2Print toolbar click Cost Report. The Cost Estimation Report will be displayed within a text file. Notice
that the 3 PDF files are in the job and each are separately calculated. The TOTAL COST of all jobs is calculated at the
bottom of the page along with the TOTAL LENGTH. Actual costs can vary based on paper choice, color profile, media
settings, as well as other factors.

STEP 1 of 3

File Media Nesting Variable Data Banner | CéstREport Setup Options

To view cost report, click Cost Report from the toolbar.

7| Cost_Report.txt - Notepad [

File Edit Format View Help
fost Calculation Report

Media Name : 11001 - Matte white Paper

Media width : 207.500 mm

Gutter : 3.175 mm

Alley : 3.175 mm

S e e e e S e e e S S e 5 3 e e S e o e s s o e s e s o s o e 5k
Job Set #1 -- Same Label Using 3 Columns

PDF Name : 14001-2_wine_(4.0x6.0)_N.pdf
Label size : 66.5057 x 107.5055 mm

CMYK Coverage
K 7.3%

= .3%
C= 13.0%
M= 14.8%
Y = 31.6%
Toner Cost per Label(cMYK) = 0.0265
Total Length Column #1 = 0.4 m
Total Labels To Print = 12
Total Toner Cost(CMYK) = 0.3177
Total Cost per Label = 0.0306
Total Cost per Job = 03673

e e e S e e e e S e e S e e S e s s S Sk S
* Job #1 Total Cost = 0.3673 *
e S S e e de S de e de e S S S e de e S e S ek

el e ek e ek e ok ok ek

* TOTAL COST = 0.3673 o
* TOTAL LENGTH = 0.4427 m *
S S 3 S e e 33 S S S s Sk e s o e o

The following window will pop up. This is the cost estimation report for the last printing job.
There are three different types of job estimation given:
Total Toner Cost = This is the cost estimate of toner ONLY

Total Cost Per Label = This takes into account the wear and tear on the drums, transfer belt and fuser. It also adds
in the cost of the media based on the length of material used.

Total Cost Per Job = This is the total estimated cost for the amount of labels you selected to be printed, including
the toner, drums, transfer belt, fuser and media.
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STEP 3 of 3

File Media Mesting Variable Data Banner Cost Report ml—

Selected Media Printer 3

11001 - Matte White Paper | Software ] ‘ Cost Calculator
Preferences + Display Options

Print Alignment
[ Die Cut Mode: | Variable Data
[ Cut On The Fy: White Toner
(& Variable Data Setup EEN—)
Dongle ID: [

Printer Output Processing
© Always Verically Processing
Always Horizontal Processing

Always Ask

Layout Display Processing
@ Display Vertical (Longer Processing)

*) Display Horizontal

Printing Options
"] Pause Before Printing
| Pause Between 1.9 GB Print Jobs
(V] Generate Cost Report After Printing

For variable data printing, you can select the above to generate cost estimation report after printing.
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5.10 Reprint Option

File Media MNesting Variable Data Banner CostReport | Options
Selected Media Printer 3
11001 - Matte White Paper Software N
| Preferences 3 | Reprint |
Warnings
[ Die Cut Made: Language
T
Click Options->Preferences->Reprint from the toolbar.

STEP 2 of 5

a5l Reprint Cptions

Enable Reprint

Check the box. This will enable the reprint option.

[EL Printing Error Detected

Waiting For Error To Be Corrected
Closing this Window Will Terminate The Print Job

Time Elapsed  00:03.9

If an error occurs, the error window will appear. Leave the window untouched.

STEP 4 of 5

~——

o . —
Go to your printer and feeder, correct the error, make the printer showing Ready to Print and feeder showing Status:
Idle. (When the printer asks to Continue of Cancel, press CANCEL button.)

STEP 5 of 5
L Printer Continue Condition : 55 inches E
I Cancel Job I [ Restart Job From Beginning ] [ Continue Job From Emor ]
I Advanced
grf;:natat_)r:js:anca 0 in U

After the machine is recovered, turn back to the software, you have options to Cancel Job, Restart Job from
Beginning or Continue Job from Error. Choose one from the window above. If you choose to continue job from
error, you have an advanced option to determine the offset distance from error.
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5.11 Warning Options

5.11.1 Consumable Warning

STEP 1 of 3

File  Media Mesting Variable Data Banner  Cost Report | Options
Selected Media Printer »
11001 - Matte White Paper Software b
w | Preferences 3 | Reprint
| Warnings
Die: Cut Mode: Language
T T Tho Ch

Click Options->Preferencés->Warnings from the toolbar.

STEP 2 of 3

o= Warnings

| Job vs Consumables

Fuser Width vs Media Width

Check the box before Job vs Consumables will enable the warnings for running out consumables.

Warning

Possible Empty Consumables If Current Job Is Printed With :
Toner Black

] | Cancel |

For Example, after you click Print, if black toner is not enough to finish the job, the warning window will pop up.
You can click OK to continue printing or click Cancel to cancel the printing job.
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5.11.2 Fuser Warning

STEP 1 of 3

File  Media Mesting Variable Data Banner  Cost Report | Options
Selected Media Printer 3
11001 - Matte White Paper Software b
Open File | Preferences  » | Reprint
| Warnings
Die Cut Mode: Language
- - ok Cvem T Chee -
Click Options->Preferences->Warnings from the toolbar.

STEP 2 of 3
ol Warnings E

Job vs Consumables

| Fuser Width vs Media Width

Check the box before Fuser Width vs Media Width will enable the warning of the fuser width according to the
media width.

STEP 3 of 3

Page Infarmation : Inches Warning

Start Position: 0.000

Media Width: 5.000 I\ This Job Will Require A Narrow 6 Fuser
Horizontal Shift (-/+): 0.000 Bpphy

Gutter: 0.000

Aley: 0.000 l oK | l Cancel ‘

For example, after you click Print, the warning window wiill pob up to let you knthhie correct size of fuser should
be used according to the Media Width you input in Page Information. You can click OK to continue printing or click
Cancel to cancel the printing job.

NOTE: This warning window will pop up every time if it's enabled.
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5.12 White Toner Warning

STEP 1 of 3

File

Media

Nesting
Selected Media
11001 - Matte White Paper

Open File

Die: Cut Mode:

i Cim Them Chee

Variable Data

Banner

Cost Report

Printer »
Software 3
| Preferences  » | Reprint
Warnings
Language

If you have white toner license activated, you can turn on/off the white toner warning.
Click Options->Preferences->Warnings from the toolbar.

STEP 2 of 3

ol Warnings

RN

Job vs Consumables
Fuser Width vs Media Width
| White Toner

Check the box before White Toner will enable the warning of the White toner cartridge before printing.

Selected Media

Selected Media
11001 - Matte White Paper

H0001 - Gloss Clear PET far White

! . Please Put White Toner In The Printer

OK

Cancel

||

'

! _ Please Put Black Toner In The Printer

OK

Cancel

| |

-_— -

=

If you select media for white toner, the warning to put white toner in the printer will pop up. If you select
than white toner, the warning to put black toner in the printer will pop up.

media other
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6 Trouble Shooting and Maintenance

6.1 Toner Cartridge Replacement

STEP 1 0f 8 ‘

1. Cyan 2. Magenta

STEP 2 of 8

Press the cover release and open the printer’'s top
cover fully. Note the position of the four cartridges.

(a) Pull the colored toner release lever on the
cartridge to be replaced fully towards the front of
the printer.

(b) Lift the right hand end of the cartridge and then
draw the cartridge to the right to release the left
hand end as shown, and withdraw the toner
cartridge out of the printer.

STEP 3 0f 8

STEP 4 of 8

sl

Clean the top of the ID unit with a clean, lint free cloth.
Remove the new cartridge from its box but leave its
wrapping material in place.

Gently shake the new cartridge from end to end
several times to loosen and distribute the toner evenly
inside the cartridge.
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STEP 5 0of 8

STEP 6 of 8

Remove the wrapping material and peel off the
adhesive tape from the underside of the cartridge.

Insert the left end of the cartridge into the top of the
image drum unit first; pushing it against the spring on
the drum unit, then lower the right end of the cartridge
down onto the image drum unit.

STEP 7 of 8

STEP 8 of 8

Pressing gently down on the cartridge to ensure that
it is firmly seated, push the colored lever towards the
rear of the printer. This will lock the cartridge into
place and release toner into the image drum unit.

Gently wipe the LED head surface with a clean, lint
free cloth.

Finally close the top cover and press down firmly at
both sides so that the cover latches closed.
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6.2 Image Drum Replacement

The printer contains four image drums: cyan, magenta, yellow and black.

CAUTION! Static sensitive devices, handle with care.

STEP 1 0of 8

STEP 2 of 8

Press the cover release and open the printer's top
cover fully.

Note the position of the four toner cartridges (a) and
image drums (b) it is essential that they go back in the
same order.

WARNING! If the printer has been powered on, the fuser will be hot. Do not touch.

CAUTION! The green image drum surface at the base of the ID unit is very delicate and light sensitive. Do not
touch it and do not expose it to normal room light for more than 5 minutes. If the drum unit needs to be out
of the printer for longer than this, please wrap the cartridge inside a black plastic bag to keep it away from
light. Never expose the drum to direct sunlight or very bright room lighting.

STEP 3 0of 8 ‘

Holding it by its top center, lift the image drum,
complete with its toner cartridge, up and out of the
printer.

With the colored toner release lever (1) to the right, pull
the lever towards you. This will release the toner
cartridge from the drum.

103




STEP 5 0f 8 ‘

STEP 6 of 8

Lift the right hand end of the toner cartridge (1) and
then draw the cartridge to the right to release the left-
hand end as shown (2) and withdraw the toner
cartridge out of the image drum cartridge. Place the
cartridge on a piece of paper to avoid marking your
furniture.

Place the toner cartridge onto the new image drum
cartridge as shown. Push the left end in first and then
lower the right end in. (It is not necessary to fit a new
toner cartridge at this time unless the remaining toner
level is very low.)

STEP 7 of 8

Push the colored release lever away from you to
lock the toner cartridge onto the new image drum
unit and release toner into it.

STEP 8 of 8

Holding the complete assembly by its top center, lower
it into place in the printer, locating the pins at each end
into their slots in the sides of the printer.
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6.3 Replacing the Transfer Belt Unit

The transfer belt unit is located under the four image drums. Switch off the printer and allow the fuser to cool for about

10 minutes before opening the cover.

STEP 1 0f 6 ‘

STEP 2 of 6

Press the cover release and open the printer’s top
cover fully.

Note the positions of the four toner cartridges (a) and
image drums (b) it is essential that they go back in the
same order.

STEP 3 of 6

STEP 4 of 6

Lift each of the image drum units out of the printer
and place them in a safe place away from direct
sources of heat and light.

Locate the two fasteners (a) at each side of the belt
and the lifting bar (b) at the front end. Turn the two
fasteners 90° to the left. This will release the belt from
the printer chassis. Pull the lifting bar (b) upwards so
that the belt tilts up towards the front, and withdraw
the belt unit (c) from the printer.

CAUTION! The green image drum surface at the base of the ID unit is very delicate and light sensitive. Do not
touch it and do not expose it to normal room light for more than 5 minutes. If the drum unit needs to be out
of the printer for longer than this, please wrap the cartridge inside a black plastic bag to keep it away from
light. Never expose the drum to direct sunlight or very bright room lighting.
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STEP 5 of 6

STEP 6 of 6

Lower the new belt unit into place, with the lifting bar
at the front and the drive gear towards the rear of the
printer. Locate the drive gear into the gear inside the
printer by the rear left corner of the unit, and lower
the belt unit flat inside the printer.

Turn the two fasteners (a) 90° to the right until they
lock. This will secure the belt unit into place. Replace
the four image drums, complete with their toner
cartridges, into the printer in the same sequence as
they came out.

Close the top cover and press down firmly at both
sides so that the cover latches closed.
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6.4 Fuser Replacement

The fuser is located inside the printer just behind the four image drum units.

WARNING! If the printer has recently been powered on, some fuser components will be very hot. Handle the
fuser with extreme care, holding it only by its handle, which will only be mildly warm to touch. A warning label
clearly indicates the area. If in doubt, switch the printer off and wait at least 10 minutes for the fuser to cool

before opening the printer cover.

STEP 1 0of 5

Press the cover release and open the printer’'s top
cover fully.

¢}
o _ \
%}J/é:ﬂ w/l
| 8| ]
\

—0

STEP 2 of 5

Identify the fuser handle (a). Pull the two fuser
retaining levers (b) towards the front of the printer so
that they are fully upright. Remove the new fuser from
its packaging and remove the transit material.

STEP 4 of 5

Holding the new fuser by its handle, make sure that it
is the correct way round. The retaining levers (b)
should be fully upright, and the two locating lugs (c)
should be towards you.

Lower the fuser into the printer, locating the two lugs
in the slots in the metal partition which separates the
fuser from the image drums .Push the two retaining
levers (b) towards the rear of the printer to lock the
fuser in place.
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STEP 50f5 ‘

Place the drums back into the printer and replace the
lid.
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6.5 Clearing Paper Jams

STEP 1 of 17 ‘

Press the cover release and open the top cover.

STEP 3 of 17 ‘

STEP 2 of 17

Note the position of the four toners cartridges (a) and
image drums (b). It is essential that they go back in the
same order.

STEP 4 of 17

Lift the image drum, complete with its toner
cartridge, up and out of the printer

Put the assembly down gently onto a piece of paper to
prevent toner from staining surrounding areas and to
avoid damaging the green drum surface and cover.

CAUTION: The green image drum surface at the base of the Image Drum is very delicate and light sensitive.
Do not touch it and do not expose it to normal room light for more than 5 minutes. If the drum unit needs to
be out of the printer for longer than this, wrap the cartridge inside a black plastic bag to keep it away from
light. Never expose the drum to direct sunlight or very bright room lighting.
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STEP 5 of 17 ‘ STEP 6 of 17

o . )

0“" -

e‘\ -
Check if any sheets of paper are visible on any part To remove sheet from the front, lift the sheet from the
of the belt unit (a. release handle, b. belt, c. fuser or belt and pull it forward into the internal drum cavity to
d. fuser pressure release lever). withdraw the sheet.

STEP 7 of 17 STEP 8 of 17

To remove a sheet from the central area, separate To remove a sheet in the fuser; push the two retaining
the sheet from the belt surface and withdraw the levers (e) towards the rear of the printer to release the
sheet. fuser. Withdraw the fuser unit using the handle (f).
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STEP 9 of 17 STEP 10 of 17

Press release lever (g) and pull trapped paper from Replace fuser unit into the machine and move locking
the fuser. levers (e) toward the rear of the machine.

STEP 11 of 17 STEP 12 of 17

Starting with the cyan image drum unit nearest the Open the rear exit tray (h) and check for sheets of
fuser, replace the four image drums into the drum paper in the rear path area (i), pull out any sheets
cavity, making sure to place in the correct order. found in this area.

STEP 13 of 17 ‘ STEP 14 of 17

If the sheet is low down in this area and difficult to
remove, it is probably still gripped by the fuser. In Pull down the MP tray using the depressions. Lift the
this case raise the top cover, reach around and front cover release lever and lower the front cover.

press down on the fuser pressure release lever (d).
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STEP 15 of 17 ‘

STEP 16 of 17

Check inside the cover for sheets in this area and
remove any that you find, and then close the cover.

Pull out the paper tray and ensure all paper is stacked
properly, is undamaged, and that the paper guides are
properly positioned against the edge of the paper
stack. When satisfied replace the tray. Close the top
cover and press down firmly so the cover latch closes.

STEP 17 of 17

Pull out the paper guide tray, clear out any paper
jams. Reload fan fold paper and close the paper
guide tray.

The following table summarizes possible causes of paper jams and suggests ways of avoiding them.

POSSIBLE CAUSE

SUGGESTED REMEDY

The printer is not level.

Place the printer on a steady, level surface.

Your print media is too light or too heavy.

Use appropriate media

Your print media is damp or charged with static
electricity.

Use media that has been stored in appropriate temperature and
humidity conditions.

Your print media is creased or curled.

Use appropriate media. Decurled media can be used.

Your print media sheets are not aligned with each
other.

Remove the sheets, jog them into alignment and reload them.

Your print media is not aligned properly in the
paper tray.

Adjust the paper stop and paper guides of the tray, or the manual
feed guide on the MP Tray to align the media properly.
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6.6 How to Print Configuration Information from the Printer

1. Press DOWN arrow, scroll to Print Information, press Enter.
2. Select Configuration, press Enter.
3. Select Execute. It will then start to print the page information.

6.7 How to Print a Secure Job from the Printer

STEP 1of 1

1. Press DOWN arrow, scroll to Print Secure Job, press Enter.

2. Select Stored Job, press Enter.

3. At this step, you have 4 passwords (0000,0001,0002,0003) for the different jobs.

e 0000 is for drum test

e 0001 is for color test

e 0002 is for die-cut test (you should use die-cut media for this job)

e 0003 is for calibration. (It is the same as Color Registration from the Software)
Press Enter after your key in the password.

Select Print.

Choose the amount of copies you want to print, and press Enter.

»os
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6.8 Sensor Calibration from the Feeder (For Die Cut Labels Only)

STEP 1 0f 11

\

Tt e R - Y
T —— e T TR

-— = R

Follow STEP 1-7 of "Loading Media for Continuous Printing" to load the roll. Place the roll of paper into the paper
tray. Feed the media through, ensuring it is underneath the tension and pinch rollers. With the media flush against
the back of the machine, ensure that there is no extra space on each side of the media and the left/right media

guides.

Close the left/right media guides. Ensure that the media is not buckling or too snug against the guide widths before
proceeding.

STEP 2 of 11
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Line up the gap of the labels about one inch below the sensor.

Cut the excess paper to make sure the top of paper is flush with the drive roller.

Backwind the roll to ensure there is no tension when the sensor is calibrating. If the roll is fully wound and has tension
on it, it will skew the calibration.

STEP 4 of 11
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Press the On Line button to take the feeder offline.

STEP 5 of 11

Press Menu twice to get to M2: Calibrations.

STEP 6 of 11

Press the UP arrow button to get to 13: Reg Sensor. Hold down the Menu button until the * disappears.
Press Menu twice to get to the sensor type. Use the UP and/or DOWN buttons to set the Gap. Then hold Menu until

it stops flashing.

STEP 7 of 11
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Press the UP arrow to scroll to 14: RSEN AutoCal and hold Menu until Ready starts flashing.
Press the UP arrow to select Execute and hold Menu until it stops flashing.

STEP 8 of 11

Status: Offline

Press Menu again and it will show Status: Offline.

STEP 9 of 11

Press the On Line button and the calibration test will begin. After the calibration is done, it will read Status: Require
Load.

STEP 10 of 11
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Statust Pabh Full

After the calibration process, press the On Line button to turn the machine Offline, and then hold the DOWN button
to cut the excess paper after the calibration is complete.

NOTE: If you press Load at this moment, the machine might show Path Full because of the excess paper.

STEP 11 of 11

Remove the paper. Press the On Line button again and select Load. Afters, the machine will show Idle and is
ready to use now that the calibration is done.

STEP 11 of 11
[, Calibrate Sensors EE

Feeder Settings Media Library Settings
Sensor Type Gap Sensor Type Gap
Sensor Gain 147 Sensor Gain 100
Sensor Window 200 Sensor Window 150
Cpen File [ Copy Feeder Settings To Media Library J [ Copy Media Library Settings To Media Library

Sensor

[¥] Die Cut Mode:

() Back

Go the EDGE2Print software, click Calibrate and then click Copy Feeder Setting To Media Library to save the
setting. Or when you print, the values in the media library will overwrite the values in the feeder.
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6.9 How to Access the Settings as an Administrator

You can set whether to ENABLE or DISABLE each category in the user menu.
Disabled categories are not displayed in the User's menu. Only a system administrator can change these settings.

1.

© 00 N o o b~

Turn OFF the printer. Turn ON the printer while pressing the Enter button. When Boot Menu appears, take your
finger off the button.

. Press the Enter button.

. At the Enter Password prompt, enter the 4-9 digit Admin password. (The default password is aaaaaa).

(a) Using the up and down MENU buttons, scroll to the required letter/digit.
(b) Press the Enter button to input and move to the next letter/digit.

(c) Repeat steps (a) and (b) until all letters/digits are entered.

. Press the Enter button.

. Press the UP or DOWN arrow button until the “category” you want to change is displayed.
. Press the Enter button.

. Press the UP or DOWN arrow button until the “item” you want to change is displayed.

. Press the Enter button.

. Using the UP or DOWN arrow button, identify the parameter as required.

10. Press the Enter button to enter an asterisk (*) on the right side of the setting selected.

11. Press the Online button to switch to online. The machine will automatically re-boot.
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6.10Paper Sensor Error Codes
381 385

. 382

380 >
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i
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= - et

Code # Location
380 Paper Feed Upper
381 Paper Transport
382 Paper Exit
385 Fuser
392 Paper Feed Lower
10-11 Load Sensors

Feeder Panel Error Messages:

Message | Issue
Msg: Guide Door Open Ensure Guide Door is Closed

- Push Guide Tray Completely into the Feeder. Ensure
Msg: Guide Tray Out Guide Tray Latches are Locked.

Msg: Close Guide Tray Ensure Guide Door is Closed

Push Guide Tray Completely into the Feeder. Ensure

Msg: Close Door/Tray Guide Tray Latches are Locked.

Msg: Funnel Full Remove all Paper from the Guide.

Msg: Path Full Remove all Paper from the Guide.
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Feeder Panel Errors:

Error ‘ Issue Solution

Status: Error 00 Emergency stop (guide door opened during | cjose poor on Feeder
motor movement)

Status: Error 01 Switch panel communication error Contact your dealer/reseller

Status: Error 02 Internal error Contact your dealer/reseller

Status: Error 03 Internal error Contact your dealer/reseller

Status: Error 10 Media not found over lower load sensor after | Do a sensor callbratlon(p.57 in the manual) or
load remove paper in path

Status: Error 11 Media not positioned between load sensors Check that media tension is not too tight
properly after load advance

Status: Error 31 ;:nlitéer did not leave home position in required Check paper jam in cutter

Status: Error 32 Cutter did not finish cut in required time or Check paper jam in cutter

can't home it

For further information, please visit the support page at www.icolorprint.com/support

Technical Support Email: support@icolorprint.com

Technical Support Phone: 631-590-1040, Option 2
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